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: & these instructions completely before operating this unit. Store this manual with care.



End-User License Agreement

THIS IS A LEGAL AGREEMENT BETWEEN YOU AND PANASONIC. CAREFULLY READ ALL THE TERMS AND
CONDITIONS OF THIS AGREEMENT PRIOR TO OPENING THE PACKET OF SOFTWARE PROGRAM. OPENING
THE PACKET INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. If you do not agree to
these terms and conditions, return the unopened packet and the other components of the Panasonic product to the
place of purchase and your money will be refunded. No refunds will be given for the products that have an opened
packet or missing components.

1. COPYRIGHT:
Panasonic has the right to license or has been granted to license the enclesed Software Program (“SOFT-
WARE"), developed and copyrighted by Kyushu Matsushita Electric Co., Ltd. or its licensor {“Licensor’). You
acknowledge that you are receiving only a LIMITED LICENSE TO USE the SOFTWARE and related documen-
tation, and that you shall obtain no title, ownership nor any other rights in or to the SOFTWARE and related
documentation, alt of which title and rights shall remain with Licensor and Panasonic.

2. LICENSE:

(1) You have the non-exclusive right to use the twenty five (25) copies of the SOFTWARE on twenty five (25)
computers. (2) Youmay install the SOFTWARE into a network server and use the SOFTWARE in your network.
But the number of the computer which uses the SOFTWARE simultaneously in the network is limited to the
number defined in the previous section (1). So far as the computer operates as a network server, the copy of
SOFTWARE that is installed into the network server is not counted as the number of copies hereof. (3) You
may not copy, reproduce, or permit to be copied or reproduced, the SOFTWARE or related documentation for
any purpose, except that you may either (a) make a reasonable quantity of copies of the SOFTWARE solely for
backup or archival purposes, or (b) transfer the SOFTWARE to a single hard disk, provided that you keep the
original solely for backup or archival purposes. (4) You may not rent or lease the SOFTWARE, but you may
transfer your right under this License Agreement on a permanent basis, provided that you transfer this
Agreement, all copies of the SOFTWARE, all related documentation and your Panasonic product, and the
recipient thereof agrees to the terms of this Agreement. (5) You may not reverse engineer, decompile or
disassemble the SOFTWARE, except that in European Union and European Free Trade Association, you may
have the limited right to reverse engineer, decompile or disassemble the SOFTWARE solely 10 the extent
specifically permitted by the terms and conditions of Article 6 of the European Community’s Directive for the
Legal Protection of Computer Programs, OJL 122/42 (17 May 1991). (6) You may not use, copy, modify, alter,
or transfer the SOFTWARE, or any cepy thereof, in whole or in part, except as expressly provided in this
Agreement. :

3. TERM:
This license is effective until terminated. You may terminate this Agreement at any time by destroying the
SOFTWARE and related documentation and all copies thereof. This license will also terminate if you fail to
comply with any term or condition of this Agreement.Upon such termination, you agree to destroy all copies of
the SOFTWARE and related documentation.

4. LIMITED WARRANTY:;
Within ninety (90} days of your receipt of the SOFTWARE, Panasonic warrants that the storage media on which
the SOFTWARE are furnished is free from defect in materials and workmanship under normal use, and that it
will repair or at its option replace any defective media at no charge to you, provided that such defective media
is returned to Panasonic within such ninety (90) days period.

5. LIMITATION OF LIABILITY:

EXCEPT AS STATED ABOVE, NEITHER PANASONIC NOR PANASONIC'S SUPPLIER MAKES OR PASSES
ONTO YOU OR OTHER THIRD PARTY, ANY WARRANTY OR REPRESENTATION INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. WITHOUT LIMITING THE GENERALITY OF THE FOREGOING, NEITHER PANASONIC NOR
PANASONIC'S SUPPLIER WARRANTS THAT THE SOFTWARE WILL BE ERROR-FREE OR THAT IT WILL
MEET YOUR REQUIREMENTS. NEITHER PANASONIC NOR PANASONIC’S SUPPLIER SHALL BE LIABLE
FOR ANY DAMAGE SUFFERED BY YOU INCLUDING, BUT NOT LIMITED TO, CONSEQUENTIAL, INCI-
DENTAL SPECIAL OR PUNITIVE DAMAGES.THE ABOVE LIMITATIONS SHALL APPLY REGARDLESS OF
THE FORM OF ACTION WHETHER IN CONTRACT, TORT (INCLLUDING NEGLIGENCE), STRICT PRODUCT
LIABILITY OR OTHERWISE, EVEN IF SUCH PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES.



Caution: This product utilizes a laser
Use of controls or adjustments or performing of procedures other than those specified herein,
may result in hazardous radiation exposure
Do not apen covers and do not attempt to repair the unit yourself Refer servicing to qualified
personnel

When you operate this equipment, the mains socket-outlet should be near the equipment and
be easily accessible

Make sure the uniti1s installed in a well ventilated room so as not to increase density of ozone
in the air Since ozone s heavier than arr, it 1s recommended that arr at floor level be ventilated

Warning: The power source voltage of this unit 1s histed on the nameplate Plug the unit only into an outlet
with the proper voltage To prevent fire or shock hazard, do not expose this product to rain or
moisture

Panasonic Process Untt

Laser diode properties KX-PEP4 ggc s
Laser output 5 mwW max 93
Wavelength 788 nm SQ: Ill%:er other than Genuine Panasonic Toner can damage
Emission duration  Continuous this process unit and the printer's fuser

THIS WILL VOID THE WARRANTY OF THE PRINTER AND PROCESS UNIT

e , )
FOR.YOUR SAEETY

To ensure safe operation the three-pin plug supplied must only be inserted into a standard three-pin power point
which 1s effectively grounded (earthed) through the normal household wiring

Extension cords used with the equipment must be three-core and be correctly wired to provide connection to
ground {earth) Improperly wired extension cords are a major cause of fatalities

The fact that the equipment operates satisfactonly does not imply that the power point 1s grounded (earthed)
and that the installation 1s completely safe Foryour safety, if in any doubt about the effective grounding (earthing)
of the power point, consult a qualfied electrician

If the plug cannot be inserted Into the mains socket-outlet, contact a licensed electnician to replace the outlet
with properly grounded (earthed) one Do not defeat the purpose of the grounding (earthing) plug (ex do not
use a conversion plug)

. S

N
( The senal number of the urt may be found on the label on the rear of the unit For your convenience, record
this number below and retain this book along with your proof of purchase to serve as a permanent record of
your purchase
MODEL NO _ KX-PS600 NAME OF DEALER

SERIAL NO DATE OF PURCHASE
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(110 - 120 V area)

DANGER-Invisible laser
radiation when open and
interlock defeated.

AVOID DIRECT EXPOSURE

Caution Label ~

Cautien,
hot surface

{220 - 240 V area)

CLASS 1LASER PRODUCT
KLASSE 1 LASER
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CAUYION-Invisible laser| VORSICHT-Unsichibare | ATTENTION-Rayonnement | PELIGRO-Cuando se abre
radiation whan open and| Laserstrahiung, wenn laser invisible dangereux en | y se invalida el bloqueo, se
imerlock defeated. Abdeckung gedfinet und | cas d'ouverture et lorsque | producen radiaciones

,, | AYOID DIRECT EXPQSURE | Sicherheitsverriegelung | la sécurité est neutralisée,  linvisibles de [Asar,

R\ | TOBEAM. {iberbriickt. MICHT DEM | EXPOSITION DANGEREUSE | EVITESE LA EXPOSICION
STRAHL AUSSETZEN. | AUFAISCEAU. DIRECTA A TALES RAYOS.

/

S FOR USERS IN UNITED STATES

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference
in a residential installation.

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

* Connect the egquipment into an outlet on a circuit different from that to which the receiver is connected.
* Consult the dealer or an experienced radio/TV technician for help.

The user may find the booklet “Something About Interference” available from FCC local regional offices helpful.
FCC Warning: To assure continued FCC emission limit compliance, the user must use the recommended
shielded interfacing cable when connecting to a host computer. Alsg, any unauthorized changes or modifications
to this equipment would void the users authority to operate this device.

Technical Support Calls

It you have read this manual and tried the troubleshooting procedures and you are still having difficulty, please
contact the store from which the unit was purchased.

You may also call the end user technical support telephone number which is operational during East Coast
business hours (9:00 AM to 7:00 PM).

The end user technical support number is 1-800-222-0584.

This number is available within the U.S. only.

Helpful Phone Numbers

To locate your nearest sales dealer

To order consumables

To order operating instructions/manuals

To locate your nearest authorized service center
For technical support

Automated 24-hour support

Fax back

Electronic bulletin board

Internet

CALL 1-800-742-8086
CALL 1-800-222-0584
CALL 1-206-395-7343
CALL 1-800-222-0584
CALL 1-800-222-0584
CALL 1-800-222-0584
CALL 1-800-222-0584
CALL 1-201-863-7845
http://www.panasonic.com

e




FOR USERS IN CANADA

Helpful Phone Number . CALL 905-238-2300

HP, PCL and LaserJet are trademarks of Hewlett-Packard Company.
IBM and IBM PC are trademarks of International Business Machines Corporation.
Microsoft @ MS-DOS @ and Windows @ are registered trademarks of Microsoft Corporation in the United States
and/or other countries. .
Microsoft Word, Write, WordPad, NotePad, Excel, At Work, Mail, Exchange, Paintbrush and Paint are
trademarks of Microsoft Corporation in the United States and/or other countries.
TextBridge ® is a registered trademark of Xerox Corporation.
TrueType is a trademark of Apple Computer, Inc.
Intel is a trademark of Intel Corporation.
Centronics is a trademark of Centronics Data Computer Corporation.
PageMaker is a trademark of Aldus Corporation.
CorelDRAW is a trademark of Corel Corporation.
AmiPro and cc:Mail are trademarks of Lotus Development Corporation.
WordPerfect is a trademark of Novell, Inc.
WinFax is a trademark of Delrina Corporation.
Eclipse FAX is a trademark of Phoenix Technologies Ltd.
Smartcom is a trademark of Hayes Microcomputer Products, Inc.
Faxworks is a trademark of Global Village Communication, Inc. '
OfficeStyler™, WinRefs™, WinStyler™, LaserAct™, WinPanel™, HostPanel™ and MXt™ are trademarks of
Destiny Technology Corporation.
Adobe Photoshop is a trademark of Adobe System, Inc, which may be registered in certain jurisdictions.

%/j\”ﬁfﬁ? As an Energy Star Partner, Panasonic has determined that this product meets

the Energy Star guidelines for energy efficiency.

All other acknowledgements are trademarks or registered trademarks of their respective holders.

All Rights Reserved. © COPYRIGHT 1996 KYUSHU MATSUSHITA ELECTRIC CO,, LTD.
© COPYRIGHT, OfficeStyler™, 1895-1996, Destiny Technology Corperation.
© COPYRIGHT, WinRefs™, 1993-1996, Destiny Technology Corporation.
© COPYRIGHT, WinStyler™, 1992-1996, Destiny Technology Corporation.
© COPYRIGHT, LaserAct™, 1990-1996, Destiny Technology Corporation.
© COPYRIGHT, WinPanel™, 1993-1996, Destiny Technology Corporation.
© COPYRIGHT, HostPanel™, 1993-1996, Destiny Technology Corporaticn.
© COPYRIGHT, MXt™, 1995-1996, Destiny Technology Corporation.

Any details given in these Operating Instructions are subject to change without notice.
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Chapter 1

Before You Start

Congratulations on your purchase of the KX-PS600, the three-in-one solution to today’s office needs. This amazing
little desktop unit can be used as a printer, a scanner and a copier.

Printer Function

B GDI Mode ( v= P. 36)

GDI Mode takes advantage of Windows™ own internal
design to print some decuments faster than most con-
ventional 600 dpi printers can. Other printers require
Windows to translate a document into a special printer
language, such as PCL on LaserJet printers. GD! Mode
reduces overhead by eliminating this translation step
before starting to print. This mode includes the following
special features. '

Printing in GDI mode may not necessarily be faster than
PCL mode. This depends on the processor and type of
PC used. For Windows 95 it can also depend whether
Windows 95 was installed as an upgrade from Windows
3.1, or a fresh installation.

Manual Dupiex Prints your document on both
Printing: sides of the paper (‘137 P. 38).
Overlay: Overlays an image over any doc-
ument { gz P. 39).
2 Up/d Up: Prints 2 or 4 pages on a single
sheet of paper to save paper
( 1= P. 42).
Image: Adjusts the brightness and con-
trast of your output (=5 P. 42).
Scaling: Reduces or enilarges your output

on printed page from 10% to
200% ( 1= P. 38).

Last Page on Top
{Reverse Order):;

Prints your document in reverse
order ( =5 P. 37).

B PCL Mode (== P. 43)

Enables you to print a file created with the MS-DOS
application or to print a PCL format file within Windows.

B Power Saving ( v= P. 34)
Saves energy while the unit is idle.

8

B KX-PS600 Software

* Provides thrae configuration options depending on
how you intend to use the unit.

For users that either do not have a
network connection or do not plan to
share the unit with others on the
network.

Personal:
{Single User)

Server: For users that plan to attach the unit
to their PC and have/plans to have
a network connection, and may pro-
vide unit sharing to other PCs on the

network.

Client: For users that will not attach the unit

to their PC but do plan to use the
printer attached to another PC on
the network.

* Enables you to install printer driver for
Windows 3.1 and Windows for Workgroups 3.11, or
Windows 95 ’

* Enables you to setup the unit
* Displays the device status

* Displays the recovery instructions when a
problem occurs

* Manages all output to the unit
* Provides the help system

B Animated Help Feature ( t= P. 45)
The KX-PS600 Device Status alerts the user of common
operational errors, Click the [ » ] button for animated
help. This feature will walk you through the steps re-
quired to get your unit running again.

B Bidirectional Parallel Interface
( = P.88)

Enables communication between the computer and the
unit,



‘ Before You Start

B Destination Panel

(Quick Operation Utility) ( v= P. 47)
This program enables you to:
. * Display the scanned documents on your PC screen
* Print the scanned documents
* Copy the scanned documents

* Convert the scanned text documents to the editable
text documents if the supplied OCR program is in-
stalled on your PC

* Fax the scanned documents if the fax program is
installed on your PC

B OCR (Optical Character
Recognition) ( v= P. 61)

This program converts a scanned text document to an

editable text document and transfer it to your word

processor. You can edit and save the document accord-

ing to that program’s procedures.

ScannerFunctwn

M KX-PS600 Document Desktop
( 1= P.50)
This program enables you to:

* Create, rename and delete folders, combine and un-
combine documents in folders, and perform editing
tasks

* View the names of all documents in the selected folder

along with information such as last saved date, file

size, number of pages, etc.

* Enlarge a page up to 200% and reduce it to 25% on
the screen )

* Search, rename, create, view, move, duplicate, de-
lete, arrange, rotate, and clean documents

* Create, navigate and ungroup multi-page documents

* Display, edit, and/or highlight a portion of the docu-
ment

* Print, fax and send documents to other appllcatlons '

without leaving the program

B TWAIN Program ( w= P. 65)

The KX-PS600 is compatible with TWAIN. Using a
Twain-compliant application, you can access KX-PS600,
scan an image and transfer it to your document.

B Local Copy ( w P. 47)

A copy can be made easily by clicking the Local Copy
button on the Destination Panel. The scan settings can
also be changed.

B Scan to PC and Printer ( = P. 47)
A copy can be made by clicking the Scan to PC and
Printer button on the Destination Panel. The scan and
print settings can be changed.

B Stand Alone Copier ( v= P.70)

Even when your unit is not connected to a PC, a copy
can be made easily by pressing the COPY button on the
unit. The number of copies and other settings cannot be
changed.

| 193doyd
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Before You Start

To avoid maching malfunctien, do not use the unit under the following conditions.

* Direct exposure to * Areas of poor * Areas of high dust or  {® Unstable or unlevel * Directly in front of air
sunlight | ventilation chemical fume surfaces conditioning vents

* Extremely high or low concentration
temperature [range: 10 (solvent etc.)
to 32.5°C (50 to 90.5°F)]

* Extremely high or low
humidity (range: 20% to
80% RH)

The following precautions are recommended to extend the life of the unit.

D)

* Use of toner other than e o not keep liquids  |* Do not add paper to the|® Do not open the left  [* Do not place the unit

Genuine Panasonic near the unit. tray while unitis printing| cover while the unit is | either on its left or right
Toner KX-PST1 can Accidental spills of asilmay cause a paper| operating. side or on its front side
damage this process | jiquid into the unit can | jam. (When you want to facing upward.

unit and the KX-PS600 | cause severe damage. | add more paper, you
unit’s fuser, THIS WILL must remove the re-

VOID THE WAR- maining paper from the

RANTY OF THE UNIT tray and then place the
AND PROCESS UNIT. entire stack of paper
into the tray.

Power Source

Minimum Space Requirements

(Rear)
* Use a voltage level marked on the nameplate (located
— Y 2em (0.8 on the rear of the unit). Be sure the voltage level does
] Ventilation space not vary more than 10%.
1] —I ‘
(Left) R Top) (Right) * This unit should be connected to a grounded outlet.
(Top
4 * Do not use a line conditioner, transient suppressor or
o surge protector which has the current capability less
|| i+ than 20A; it may cause a machineg error. When these
20 6m (8.0" (Front) | 40 cm (15.8") Paper tray g%vrl:?s argoised, be sure the current capability is
Left cover opening space an :
opening space 2 cm (0.8")

Ventilation space

10



" Before You Start

System Requirements |

To run the KX-PS600 software, you need the hardware and software given in the following tables.
Hardware requirements differ between the three software configuration options: Personal, Server, and Client..
Hardware Requirements Personal Server(s) Client(s)
Minimum GPU | Windows 3.1 or iB0386DX i80386DX i80386DX
Workgroups 3.11 (i80486DX) (i80486DX) (i80486DX)
Windows 95 i80386DX i80386DX i80386DX
(i80486DX)* {i804860DX)" (i80486DX)"
Minimum Processing Speed 25 MHz (33 MHz)* 33 MHz 25 MHz (33 MHz)* )
Free Hard Disk Space - 20 MB 20 MB " 20MB
Minimum PC RAM 8 MB (16 MB)" 8 MB (16 MB)* 8 MB (16 MB)*
Centronics Parallel Port v v S X
Network Card X v v
Netvxfork cable, connector(s), and % s /
terminator(s)
Network adapter driver X v v
* Recommended v required X : not required
Software Requirements Personal Server(s) Client(s)
Windows \\ilvvlir:cjj%\:vss ?01 Windows for Windows for
Workgroups 3.11 Workgrgll.’nps 311 Workgr%l:ps 3.1
or . .
Windows 95 Wmdo‘ws 95 Windows 95

(= P.21)

Minimum Virtual Memory *!

12 MB (16 MB)*

12 MB (16 MB)*

12 MB (16 MB)*

* Recommended

. *V Virtual Memory should be permanent in Windows 3.1, Windows for Workgroups 3.11.

11
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Before You Start

Make sure that all of the items shown below were provided and have not been damaged. Report damage or shortages
to the store from which the unit was purchased. On page 3, there is an area for recording important information such
as the serial number, date of purchase and your dealer name.

Process Unit Paper Tray Document Feeder Document Output

g::;zs:;i)n( :Jr:i pF:i-nlgr)) (1= P. 15) Tray (1= P. 15) Tray( o5 P. 15)

==

Power Cord TeitBridge Disks Operating Instructions
(o3 P. 16) Utilities Disks (i P. 22) {15 P. 23) Manual
Note:

* Itis recommended that you save the original carton and packing materials for future shipping and transporting
of the unit. They have been specifically designed to protect your unit during shipment.

Part Names

Paper output support (155 P. 17) Document feeder support

Output tray {top cover) ( ws P. 48)

{vz P.17)

Document feeder tray
(s P.15)

) Scanner door
Indicators and Button (= P. 73)

(1 P.13,77)

Process unit
(I P. 14, 81) Document output tray ‘%\/X
(1=F P. 15)
Paper support
(= P. 17}
Paper tray { 15 P. 15)

Power switch { 155 P. 16)
Power connector plug { IZF P, 16)

Left cover { vz P. 14, 72)

Frame ground terminal {tse P. 16)
Parallel interface connector { 1= P. 16, 88)

12




Before You Start

ERROR indicator //D &, \\ READY indicator

(w5 P. 77) |_I O (1= P.77)
ERROR READY

TONER/PROCESS UNIT

indicator (v P. 77) | f‘. | / 4.(@

TONER PROCESS UNIT
\\ CoPY [ /I, COPY button

(= P.70,77)
START/STOP —
Indicators
L 1O 14/-@4 Printer/Scanner/Copier status
TONER/
ERROR | READY | PROCEES
UNIT
o | W 0 Warming up
| B O Ready for printing, scanning and copying
o | w 0 Receiving data, printing, scanning, or copying
w | 0 n Process Unit is not installed
o |- o ] Add toner
m on ‘& : blinking (fast — with an interval of about 1 second)

0 off 4: blinking (slow ~ with an interval of about 2.5 seconds)
* For more detailed information on error indications, refer to page 77.

COPY button:

COPY will execute one of the following functions depending on the status of the unit { 1= P. 70).
When copying through PC, settings can be changed ( 1= P. 47).

Indicators

LI O L‘E’J/‘ ' Function

TONER/
ERROR | READY | PROCESS
UNIT

Start making a copy in the Text mode {300 x 300 dpi) by pressing this button for less than 2
seconds when a document is inserted in the document feeder tray

Start making a copy in the Text & Pheto made (300 x 300 dpi} by pressing this button for
g u ] more than 2 seconds (READY indicator blinks) when a document is inserted in the document
feeder tray

Start making a demo print by pressing this button for more than 2 seconds when a document
is not insented in the document feeder tray

s

O [ | 0l Stop making a copy by pressing this button when copy is executing

m:on [i: off 'w: blinking (fast)

13
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Chapter2 Setup

Process Unit Installation =

Important:

To prevent any damage to the Process Unit, observe

the following precautions.

¢ Do not touch the green drum surface. Lift the
Process Unit by holding the green labeled tabs.

* Do not expose the Process Unit to direct sun-
light or artificial light for more than 5 minutes,

* Do not keep the Process Unit near dust or dirt.

* Do not place the Process Unitin a high humidity
area.

Installing the left unit stand
* To further stabilize
the unit, remove (@ )
and reinstall { @ ) the
left unit stand before
installing the Process

Unit. ’

Open the left cover by gently pulling the
cover release tab.

Cover
release tab

2 Remove the Process Unit by grasping the
green labeled tabs and pulling it toward you.

14

Open the plastic bag and remove the
Process Unit.

4 © Remove the protective sheet.
@ Remove the tapes.

Install the Process Unit by grasping the
green labeled tabs and pushing it firmly into
the unit.

6 Close the left cover.

Notes:

* PLEASE DO NOT THROW AWAY THE PACK-
ING MATERIALS. YOU MAY NEED THEM TO
SHIP CR TRANSPORT THE UNIT.

* TO PROVIDE OPTIMUM PRINT QUALITY,
THE UNIT MUST BE KEPT UPRIGHT AND
LEVEL AT ALL TIMES.
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To install the following trays, perform steps 1~3 below

* Paper Tray i
* Document Qutput Tray
* Document Feeder Tray

Align the lower left and right ends of the
paper tray with the guides and push the
paper tray firmly into the unit

Paper Tray

2 Align the left and night tabs of the document
output tray with the guides. Push the docu-
ment output tray firmly into the unit until 1t
clicks

7

Document Qutput Tray

In§en the left and right tabs of the document
feeder tray into the slots keeping the tray at
about 45°. Firmly push the document feeder
tray into the unit.

Document
Feeder Tray

15
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Connecting the Unit and
Power On

This unit is equipped with a bidirectional parallel inter-
face (1= P. 88). If you do not have a bidirectional
interface cable, you will need to purchase one from your
local computer store or dealer.

1 Turn OFF the unit and computer.

..

2 Plug one end of the cable into the parallel
interface connector of the unit.
Snap the clips into place.

> Clips

e &

/
W/

If the cable has a frame ground wire, connect
it to the frame ground terminal.

Notes: ;

* Be sure to use only a shielded bidirec-
tional parallel interface cable. Other-
wise the unit may not operate properly.

* The unit will not operate properly if any
of the pins are not connected.

16

Plug the other end of the cable into the
connector on the computer.

Notes:

* The actual connector on the PC may
differ depending on the manufacturer of
the computer.

* If the cable is connected to the PC via
printer buffer or selector, the unit may
not print.

Plug one end of the power cord into the unit’s
power connector plug.

Plug the other end of the power cord into a
three-pin socket outlet which is properly
grounded.

6 Turn ON the unit.

The unit is warming up.

The READY indicator will start blinking.

It will take about 40 seconds to warm up when
turning on the unit or releasing from Power
Saving Mode ( 1= P. 34).

The unit is ready for printing.
The READY indicator is on.



Loading Paper/Envelopes (Labels, Transparencies)

“Loading Paper .

This unit has a multi-purpose paper tray. The paper size
selected through the GDI Mode ( wx P. 36) or PCL
Mode ( s P. 43) and your software application should
alsoc match the size of the paper in the paper tray for
proper print alignment. :

1 © Open the output tray (top cover).

@ Extend the paper output support by
sliding it upward, :

———

2 © Separate the paper guides to the
approximate width of your paper.
Refer to the size indicators above the paper
guides for accurate paper width.
@ If you load the legal size paper, extend the
paper support by holding its top edge and
sliding it upward. '

Note:

75 g/m? (20 Ibs.) paper in the papertray.

* You may load up to 100 sheets of J

@ Insert the paper into the paper tray fully.

The height of paper should not exceed the
limit mark onthe paper guide, orit may cause

a paper jam.
® Adjust the paper guides to your paper
size.

@ Raise and hold the document output tray.

Fan a stack of paper and tap it on a level
surface to avoid paper jams or skewed print-
ing. ‘

Notes:

* |f the paper guides are not adjusted properly,
your printout may be skewed.

* Do not load paper of different types or thickness
"in the paper tray at one time; this may cause a
paper jam.

* When you want to add more paper to the paper
tray, you must first remove the remaining paper
from the tray and then place the entire stack of
paper into the tray. ‘

* Make sure you load the paper with the print side
up. Most paper has instructions recommending
the side to be printed first. When using 60 g/m?
(16 Ibs.) paper, always load the paper with the
“non-curl side” up rather than following instruc-
tions on the paper package.

* For more detailed information on paper, refer to
“Paper Specifications” ( g5 P. 85).

* Do not allow more than 50 sheets [75 g/m2 (20
Ibs.})] to accumulate in the output tray. This may
cause a paper jam.

U U |
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Loading Envelopes
(Labels, Transparencies)

You may load either 30 sheets of labels, 30 transparen-
cies, or up to 10 envelopes in the paper tray. You can
use Business Commercial #10, Monarch, International
DL and International C5 envelopes. For more detailed
information on Envelopes, refer to “Envelope Specifica-
tions” ( i= P. 87).

' Notes: :
~ ® Make sure that all seams are properly sealed
before loading envelopes.
* The envelopes must be loaded with the shorter |
side first to avoid a paper jam. l
i * When installing envelopes, the flaps should be |
I face down. {
* To print tengthwise on the envelope (along the
longer side}, set the printing mode to landscape
(o P. 36, 43).

RN — L eem - [ - [REPHSE -

!
1
[
|
1

1 ©@ Open the output tray (top cover).

@ Extend the paper output support by
sliding it upward.

Adjust the paper guides to the approximate
width of your envelope.

18

3 Insert the envelopes into the paper tray fully

with the sides to be printed facing up. Posi-
tion them between the paper guides, and
adjust the guides until you feel resistance.

Front Flap {face down and toward
the front side of the unit)

Verify that your envelope matches the paper
size set through the GDI Mode ( v P. 36) or
PCL Mode ( ¢z P. 43) and software applica-
tion for proper print alignment.
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KX-PS600 Configuration Overview

KX-PS600 provides three software configuration op-
tions depending on how you intend to use your unit

* Personal
* Server
®* Client

Whether you use the unit in a network configuration or
as a non-network printer, your configuration will provide
all the same pnint modes and unit features Network and
resource* sharing related features are not available in
the “Personal” configuration

* A resource 1s a prece of data, software apphication, or
hardware that can be accessed and used by multiple
users or system components A resource provides a
senvice

The Personal configuration 1s for users that are not
connected to a network, or will not use the unit as a
shared network resource If at some point, you choose
to add network capabilities to your PC or you choose to
allow the unit to be a shared network resource, you will
have to re-install the KX-PS600 software ( = P 22)
and select the Server User Type option (15 P 22)
However, note the hardware requirements for Server
PCs { ¥ P 11) to ensure that you have the minimum
hardware necessary to install as a Server

E«‘Network Conf.'gurat.'on

Microsoft Windows for Workgroups 3 11 or Windows 85
1s designed as a peer-to-peer network That 1s, each
connected PC 1s a peer to every other connected PC in
the workgroup This peer approach means that no PC
i the workgroup acts as a network administrator The
PC that has the printer connected to it performs some
additional functions not needed by PCs without a con-
nected printer Therefore, we have adopted the Cli-
ent/Server terminology to differentiate between those
PCs that have a printer connected to them and those
PCs that do not have a connected pninter A Server Is
that peer with a connected and shared printer A Client
IS & peer using a prnnter connected to a Server

o= e e o B

;
1

1
|
' KX-PS600 software { 1= P 22) installed and
)
;
|

H
L on the Server PC will slow down when the Client

Note:
* For peer to peer access, both peers must have

|
l

selected in their Windows pninter list

* A maximum of 25 PCs on the network can use
the KX-PS600

—— e e

Server Configuration

The Serveris the peer in the workgroup that has a printer
connected to it At installaton, the KX-PS800 Setup
program asks If you wish to configure the PC as a Server
or aClient You must configure the PC with the attached
printer as a Server

f_ Note

* If you previously installed and configured your
PC as a Client, you must reinstall yourunitasa
Server{ 1 P 22) |

* The processing speed of the application running

pnnts to the Server's prmter

Any Server in the workgroup with KX-PS600 software
(1 P 22)nstalled can be effectively both a Server and
a Chent As a Server, that PC shares the connected
pnnter with other peers in the workgroup However,
when that server opts to print to a printer supported by
another Server, that PC 1s acting as a Client to the other
Server

Client Configuration

The Client 1s a peer in the workgroup that wants to pnnt
to another peer’s printer

PR,

Note !

* Scanner and copier function software cannot |
install the PC as a Client

1
'
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Setup\

Network Configuration Example =

As you can see in the following figure, there are two PCs
that have attached printers:

® Peer A with Printer A
* Peer D with Printer D

If Peer B chooses to printto Printer A, Peer B is the Client
and Peer A is the Server for that print job. If Peer A wants
to print to Printer D, Peer A becomes a Client to Peer D,
but Peer A remains the Server for Peer B's print job.

Printer A

PeerB
(Client)

Peer C
(Client)

Printer D

20

Installing the Network
Connection on Your PC

This section is for users that share the KX-PS600 on a
network or for Clients that will use a shared printer. Skip
this section if you plan to install the Personal configura-
tion option. To use the KX-PS600 in a network, the
Windows for Workgroups 3.11 or Windows 95 network
has been constructed in advance.

To install a network connection on your PC, you need a
network card adapter (either an internal bus card, an
external PCMCIA card, or a parallel port version) and
network software, Refer to your Microsoft documenta-
tion and network interface card or network adapter doc-
umentation for specific details regarding network
connectivity and configuration. Using Microsoft Win-
dows for Workgroups 3.11 or Windows 95 will provide
you the network connectivity necessary to use the
KX-PS6800. Refer to the steps below to install a network
connection on your PC.

environment,

Step Action Comment

(1 Setup a peer-to-peer | Refer to your
Windows for Work- Windows for
groups 3.11 or Workgroups 3.11 or
Windows 95 Windows 95 and

network adapter
docurnentation.

2 Enable the peer-to- This step is
peer network by recommended to
ensuring that peers ensure that your
cancommunicatevia | network is
the Mail and Chat operational and all
applications. connected network
peers can
communicate.
3 Set Virtual Memory. Minimum virtual

memory of 12 MB is
required ( e P. 21).
For Windows 3.1 or
Windows for
Workgroups 3.11,
permanent memory
rather than
temporary memory is
recommended.

Note for Network Protocol:

* To use the KX-PS600 in the network the follow-
ing Network Protocol is needed: “NETBEUI" or
“IPX/SPX compatible protocol with NetBIOS”.
Refer to the Microsoft Manual for more informa-
tion.




Setup

Allocating Virtual Memory

“For Windows 3. 1or Wmdows
-;~for Workgroups 3 11

The KX-PS600 software requires a minimum of 12 MB
of wirtual memory for Perscnal, Client and Server con-
figurations

To change the wvirtual memory, follow the instructions
below For more information on virtual memory, refer to
the Optimizing Windows section in the Microsoft Win-
dows 31 or Windows for Workgroups 3 11 User's
Guide

1 Double click the Main icon from the
Program Manager screen

Double click the Confrol Panel icon.

Double click the 386 Enhanced con.

Click [ Virtual Memory |.

Itthe size shown in the Virtual Memory dialog
box is less than 12,000 KB, then click

Otherwise click to exit the dialog box

N & WON

6 Select the Type “Permanent” in the New
Swapfile Settings box.

7 Increase the New size in the New Swapfile
Settings box to at least 12,000 KB.

| _“NOtE' ) o — l

i ¢ If you cannot increase the New size to
! the desired figure, then select the Type ’
the wirtual

“Temporary” and set

' _memory size

8 Chck [OK].

R

Q Cuick [Yes].

4() Chck [Restart Windows | to make the setting
effective.

} For Windows 95

It 1s recommended that you let Windows manage your
virtual memory However, if your system has slowed
down Or you are experencing memaory errors you need
to manually increase the virtual memory, follow the
instructions below

1 cnck , move the pointer to “Settings”
and chck “Control Panel”.

2 Double click the System icon
“System Properties” window will be displayed

Click the “Performance” tab.

Click [ Virtual Memory.. |.

Click the “Let me specify my own wvirtual
memory settings” button.

4

Increase the Mimimum setting to at least 12.

o))

Click

“Confirm Virtual Memory Settings” dialog will be
displayed

N

Chick [Yes].

Chick

“System Setting Change” dialog wilf be
displayed

10 Click to restart Windows.

21
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Installing the KX-PS600 Software

The KX-PS600 software installation analyzes your sys-
tem configuration, installs the software, and makes the
necessary changes to Windows startup files. Installation
can be performed from the installation disks.

The KX-P5600 scoftware installations will create and let
you use the following.
* KX-PS800 Printer Console { i P. 30)

.—includes printer drivers for Windows 3.1 and Win-
dows for Workgroups 3.11, or printer drivers for
Windows 95

-—enables you to setup the unit in Windows

¢ KX-PS600 Destination Panel ( tss= P. 47)

—includes quick operation button for scanning

* KX-PS600 Document Desktop ( 1= P. 50)
—includes the image management software
* TWAIN Program { oz P. 65)
—includes a TWAIN driver

Notes:

* When the KX-PS600 software installation is
attempted on your system with the KX-P&100,
KX-P8500, KX-P6300 or S300 scftware already
installed, the following message will be dis-
played.

e ]

[) Another varsion of softwaie similar o KX-PSEDQ is found. Do you
wart lo remove i ?

il [ [T cence ]
Click to remove the installed driver.

* When using the KX-P6100, KX-P6500 or
KX-P6300 printer after using the KX-PS600,
you need to reinstall the corresponding printer
driver.

* |f you wish to discontinue installing the software
during installation, first complete the instailation
procedure, then use the Uninstall Utility to re-
move ( e P. 27). ‘

* |f you are using the scanner which occupies
centronic port, disconnect it and remaove the
driver of this scanner. '

* Thescreen messages may be different depend-
ing on the version of Windows 95. In this case,
install the printer driver by following its screen
messages.

22

Installing the Image Manage-
ment Ulilities

B For Windows 3.1 or
Windows for Workgroups 3.11 users:

1 To start Windows in the 386 Enhanced Mode,
type WIN at the DOS prompt and press

2 Insert the Image Management Utilities disk 1
of 4 (#1} into disk drive A.

3 From the Program Manager, click “File”.
Then click “Run...”., Go to step 4.

B For Windows 95 users:

1 Start computer using Windows 95.

2 Insert the Image Management Utilities disk 1
of 4 (#1) into disk drive A.

3 Click and click “Run...”.

4 Type ANINSTALL and click [OK].

If you are installing the software on a

server/personal, click .

SB If you are installing the software on a client,

click [No Printer .
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The Setup Program has determined the fol-
lowing user configuration. If necessary,
make appropriate changes to this window.

aonic KX-PS600 Setup i - x|

The setup program has determined the tollowing user
configuration tor your KX-FS600 installation. Make any
necaessary changes and press {Continug].

Max. 15 characters are aveilable for computer name,

Usef Type: IPErSwa1 1FJIi

Computar Name: @5} - _jl

Comments: ’7 "

KX-PS600 Directory: [c:\KxPssnn _ “JJ
ﬂgnnlinue | ||—__Quit 1 r—ﬂ—el—p———]

* User Type: Select Personal, Client or Server de-
pending on your computer configuration. If your com-
puter is not connected to any neiwork, only Personal
will be displayed,

* Computer Name: You must type in the name of the
computer network or computer name, up to 15 char-
acters, in the Computer Name field.

* Comments: Type in any comments in the comments
field. Forinstance, software versmn No or your name,
ele.

¢ KX-PS600 Directory: If you wish to install the
KX-RPS600 for Workgroups software for Windows on
another drive.and/or directory, type the letter of the
drive and/or directory name in the KX-PS600 Directory
field.

7 Cick [Gontinue].

The Setup Program has determined the
following printer configuration.

[x]|

[Ponasonic KX-PS600 Sctup

The satup program has determined the following printer
configuration lor your KX-PSE0D instaliation, Make any
necessary changes and prass [Continua].

Panasonic KX-PSE00 |
Parailel Port: |Lp'r|; ff:i
Fm:nl B ) Iﬂ

IMI'.Iin Tray !:'J °

™ am

* If necessary, make any changes to this
window.

Printer Typa:

Delault Connection to:

Options:

|rgnminua i Ihﬂelp i

Click [Continue |.

Follow the instructions on the screento mstall the
" Image Management Utilities from disks 1 to 4.

TexiBridge Installation K
insert TextBridge Installation Disk #1
Select Drive
®)Drive A @
Q0o & s
Note:
* There is no TexiBridge installation for
the Client.

1 0 A 'fyou wish to use “TextBridge” (OCR)
(= P, 9), insert-the TextBridge-disk 1 of 3
mto disk drive A. Then click

Follow the instructions on the screen to com-
plete the installation.

If you do not wish to use “TextBridge” (OCR),

108 then just click [SKIP].

* it is possible to install the “TextBridge”
later, even if you skip “TextBridge” in-
stallation. For installation, refer to

' “TextBridge Software” on page 67.

, Note: |
|
!

1 1 Remove the inserted disk.

1 2 Click | Restart Now | to restart Windows.
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Installing the Software on a Server/

Personal (Plug & Play)

1

2

24

Turn the Printer on

Confirm the READY indicator 1s lit

Start computer using Windows 95.

“New Hardware Found” window will be
displayed

¢ If the printer 1s not READY, “New Hardware
Found” window will not be displayed After the
printer 1s READY, turn the computer off then
on again

Click

“Install From Disk” window will be displayed

Insert the Image Management Utilities disk 1
or 4 (#1) into disk drive A.

Click

First, the “Panasonic KX-PS600” window will be
displayed, and then the “Panasonic KX-PS600
Setup” window will be displayed

Perform steps 6~12 of “Installing the Image
Management Utilities” on page 23 to com-
plete the installation.

- - 1
: Note:

* The Installation window lies behind H

other windows To bring the installation
window to the front, close other i
windows

Installing the Software on a Client

(Add Printer)

1

W N

0 N O O

11
12

13

Start computer using Windows 95,

Insert the Image Management Utilities disk 1
of 4 (#1) into disk drive A.

Click , move the pointer to “Settings”
and click “Printers”.

Double click the Add Printer 1con.

“Add Printer Wizard” window will be displayed

Chck [Next> |.

Click “Local printer”.

Click [Next> |.
Chek :

“Install From Disk” window will be displayed

Chek [OK].

Click “Panasonic KX-PS600” in the Printers
box

Click twice
Click :

First, the “Panasonic KX-PS600” window will be
displayed, and then the “Panasonic KX-PS600
Setup” window will be displayed

Perform steps 6~32 of “Installing the Image
Management Utilities” on page 23 to com-
plete the installation.

Note:

& The Installation window lies behind
other windows To bring the instalfation
window to the front, close other
windows
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Printer Resource Sharing

If durning nstallation you have selected Personal or - - -

()
=
O
-
/7]
-
b
X
=

Client, skip this section 7 A To Remove unauthorized client(s)

® Select chents from the “Share with” hist box,
The server prlnter must be shared and the client must then select the Remove button (Se|ect Re-
be one of the authonzed users of the server before a move Allwill unauthonze all current connected
Client can print to the KX-PS600 chents )

To share a printer resource the Server must perform the
following steps TB To add authonized client(s)

* Select clients from the “Choose from” list box,

. then select the Add button (Select Add All will
B For Windows for Workgroups 3.11 users: authorize all current and thereafter connected

clients to share the printer )

1 From the Program Manager, double click the
Panasonic KX-PS600 Tools icon.

8 Click [OK].

2 Double chick the Printer Console icon. Printer sharing will be established autoratically
Gotostep 3 every time Windows starts up

B For Windows 95 users:

1 Chek , move the pointer to

“Programs”, then to “Panasonic KX-PS600
Tools”

To stop sharning the KX-PS600 resource, perform the
following steps
2 Click “Printer Console” .

1 Perform steps 1 to 4 of “Printer Resource
Sharing” above.

3 Click the “Control Panel” tab or “Network”

menu 2 Click off the item(s) that you want to stop
_ sharing
4 Click E@ or “Share Printer”.
3 Click

5 Click on the item{s) that you want to share.
(1e GDland PCL)

Buleys a821n0say Jajully / @1eMPyoS 009Sd-XM a8y Buljeisuy|

6 Click [Clients .

25
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Connecting a Client PC to a
Shared Printer

Before a Client can print, the Client must connectto a
shared printer resource. To connect to a shared printer
resource, the Client must perform the following steps:

B For Windows for Workgroups 3.11 users:

1 From the Program Manager, double click the
Panasonic KX-PS600 Tools icon.

2 Double click the Printer Console icon.
Go to step 3.

@ For Windows 95 users:

q Click [Start], move the pointer to

“Programs”, then to “Panasonic KX-PS600
Tools”.

2 Click “Printer Consote”.

3 Click the “Control Panel” tab or “Network”
menu.

Click or “Connect to ...".

Click on the “Remote Printer on” button.
Select a Server you want ta connect to.

The selected server can be used for all your
print modes by clicking on “Server of All
Virtual Printer” box.

~N O O A

§ Click [OK].
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Testing the Unit

To verify that the software instaliation was successful,
perform the following steps after confirming that the unit
is ready and paper is loaded.

B For Windows 3.1 or
Windows for Workgroups 3.11 users:

1 From the Program Manager double click the
Panasonic KX.-PS600 Tools icon.

2 Double click the Printer Console icon.
Go to step 3.

B For Windows 95 users:

1 Click , move the pointer to
“Programs”, then to “Panasonic KX-PS600
Tools”.

2 Click “Printer Console”.

Click the “Control Panel” tab.

Click the Tg’, {Print Configuration Page)
button.

The Print Configuration Page screen will be
displayed.

5 Click [Yes].

Configuration

Software Verson' 300
Calp. Friday, August 30, 1586
Time: 17:00.53
Processor, 80536
Coprocessor.  Prasent
DOS verzion: 1.0
Windows Vevsion: 40
Winciows Mode:  Enhencad, Lol
Output Port  LPTY:
Tolal RAM Size' 18384 K Bytas
Sysen Resourcea: 71% Free
Usar Resocrces 71% Free
G¥ Resqurcas: 84% Free
Global Heup Avadabi Memory: 135, 740.P28 Bymes

Dask Space: 42442752 Byeson C.
el
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Removing the KX-PS600

Note:

o
=
O
A
7]
-
>
X
-

* it is recommended that you close all active Software
Windows applications before printing a config-
uration page, and make sure that there are no If you need to remove the KX-PS600 software, perform
print jobs paused in the KX-PS600 Printer Con- the following. .

sole ( oz P. 32). Otherwise, configuration print-
ing may not be possible.

B For Windows 3.1 or

; Windows for Workgroups 3.11 users:

1 From the Program Manager double click the
Panasonic KX-PS600 Tools icon.

Z Jeydoyd

2 Double click the Uninstall Utility icon.
Go to step 3.

B For Windows 95 users:

] Click [Start], move the pointer to

“Programs”, then_to “Panasonic KX-PS600
Tools",

2 Click “Uninstall Utility”.

Click [OK].

4 The one remaining file (detete.exe) and
“Panasonic KX-PS600 Tools” directory must
be manually removed by the user after uni-
nstallation.

Note:

¢ Do not remove the files under the “Data”
directory if you want to leave the
scanned data in Document Desktop
( == P. 50) when you reinstall the
KX-P5600 software.

aremyjog ayy) Buirnoway / wun ay) Bunsal 7 9d wald e Bunosauuo)
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Chapter3 Printer Function

Print Modes _

Print Mode Selections

You can select either of the two print modes, GDI Mode
( b= P. 36) or PCL Mode { 1z P. 43), according to your
requirements. If you cannot determine which print mode
is best suited for your printing applications under Win-
dows, we recommend you always use GDI Mode first.

GDI Mode has the following features:

* faster printing than most conventional 600 dpi printers
for some documents

* manual duplex printing ( w5 P. 38)
* |ast page on top (reverse order printing) { = P. 37)
* overlay ( oz P. 39)

PCL Mode is effective in the following cases:

* when you want to print a file created with an MS-DOS
application

* when you want to print a PCL format file

* when you want to print an ASCIi formatted file

28

Printing Documents

Printing From a Windows
Application

Once you have selected your print mode (GDI or PCL
emulation *}, just print from your Windows application
as you would to any other printer.

* Emulation means to operate like another printer.

Printing From a DOS Application
Within Windows

The KX-PS600 is a Windows printer, designed for use
with Windows and does not work with MS-DOS. How-
ever, if the KX-PS600 is in PCL Mode (HP LaserJet
Series lIP emulation), it can print a POS application file
as follows:

W For Windows 3.1 or
Windows for Workgroups 3.11 users:

Double click the MS-DQS icon in the Main window, start
the DOS application and print a file.

* |f you could not print, then you may need to check to
see if your DOS icon is tagged “Exclusive”, If it is so,
then you must change it to non “Exclusive”

( vz P. 786).

B For Windows 95 users:

Click , move the pointer to “Programs” and click
“MS-DOS Prompt®. Then start the DOS application and
print a file.

Notes:

¢ |t is recommended that you close all active
Windows 3.1 applications before printing from
DOS. However for some DOS applications
which do not run successfully with Windows in
the background, you will nct be able to print.

* When printing from DOS using the "Shift+Print
Screen” keys or DOS application, it may be slow
to print. Please only print once, as it may take
more than 1 minute before printing commences.
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Changing the Print Mode '

There are three methods of changing the print mode
between GDI Mode and PCL Mode (see A, B, and C).
However, some applications allows you to change the
print mode only through method A.

¥ From an Application

Most of the popular Windows applicgtions allow you to
change GDI Mode/PCL Mode. For example, to change
the mode in Microsoft Write, perform the following.

1 Select “Print Setup...” under the File Menu.

The Print Setup window will be displayed.

Select the desired print mode.

3, Click [OK].

E From the Printers in Windows

W@ For Windows 3.1 or
Windows for Workgroups 3.11 users:

q Double click the Main icon in the Program
Manager to display the Main window.

2 Double click the Control Panel icon in the
Main window.

3 Double click the Prinfers icon in the Control
Panel window.

4 Select the desired print mode.

5 Click [Set As Default Printer |.

The print mode you selected in step 4 appears
in the Default Printer field.

6 Click [Close].

B For Windows 95 users:

2 W N

}
From the Contro! Panel Tab of the
KX-PS600 Printer Console

B For Windows 3.1 or
Windows for Workgroups 3.11 users:

1

Click , move the pointer to “Settings”
and click “Printers”.

Select the desired printer’'s icon.
Click “File” and "“Set As Default”.

Click “File” and “Close”.

¢ 1aydoyd

Double click the Panasonic KX-PS600
Tools icon in the Program Manager to dis-
play the Panasonic KX-PS600 Tools window.

Sapo juld

Double click the Printer Console icon.
Go to step 3.

B For Windows 95 users:

2

Click [Start ], move the pointer to
“Programs”, then to “Panasonic KX-PS600
Teols”.

Click “Printer Console”.

3
4

Click the “Control Panel” tab.

Click the Printer list box.

5 Select the desired print mode.

6
7

Click |Set As Default |.
Click “File” and “Exit”.

29
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KX-PS600 Printer Console

The KX-PS600 Printer Console provides asingle access
point to the four major program screens. The purpose of
the KX-PS600 Printer Console is to provide an easy
means to configure the KX-PSB00 and to monitor and
control print jobs.

To display the KX-PSE00 Printer Console window, per-
form the following.

B For Windows 3.1 or .
Windows for Workgroups 3.11 users:

From the Program Manager double click the
Panasonic KX-PS600 Tools icon.

2 Double click the Printer Consele icon,

B For Windows 95 users:

1 Click | Start], move the pointer to
“Programs”, then to “Panascnic KX-PS600
Tools™.

2 Click “Printer Console”.

¢ KX-PEGO0 Frintar Console

Efe i tewap bawed Pee pei

[” | Femote Queus 1 JobLog T Gortrol Paned

=T = - i

e [eE]

Paze | R e god |} ede 31500 sty Joba crty
3ot Hatve

Jrosma] Size| Tuma Joviner ]

ﬂ,m;;;..m |

Each of the four major program features can be viewed
by clicking the tab under the window menu bar. The four
tabs are:

* | ocal Queue

* Remote Queue
* Job Log

¢ Control Panel

For descriptions of the menu bar items, refer to
“KX-PS600 Printer Console Menu Items” on page 34.
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Help System

The Help menu informs you of the KX-PS600 Help
system. Within the Help system, you can select Con-
tents to see a list of topics related to the KX-PS600.

To display the Help menu, perform the following:

B From the KX-PS600 Printer Console
window

1 Click “Help” on the menu bar.
2 Click “Index”,

3 Display your desired item using “Contents”
or “Search”.

4 Click “Fife” and then click “Exit”.

You will exit the Help menu and return to the last
~ window.

B From the Options or Overlay screen

1 Click “Help".

Perform steps 2~4 of “From the KX-PS600
Printer Conscle window” above.
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The Control Panel provides the mechanism to configure
and control the unit Figure A shows the Control Panel
tab of the KX-PS800 Printer Console The Control Panel
1s divided into five button categones, the printer informa-
tion and printer selection display The Printer group item
presents the currently selected prninter and provides a
hst of additional printer selections The printer selections
apphcable to your unit are

* Panasonic KX-PS600 GDI
* Panasonic KX-PS600 PCL

To display the Control Panel features, click the “Control
Panel” tab in the KX-PS600 Printer Console window

Figure A

S( KX-PS600 Printer Censelw
Fiw Yuw Sritem Netmb Ry bt

Lonioevs ]| RemoleQuew | patoy [T Comrol Penel
CFS [# 1= el ik e])
-Ip::_'c“;; Paneson KX PS600 GDI — I [T __ss At Defsun —THI f

| I Cacvoawce swus_ |

[ @ Prict to_DEFAULT (Lacaly

(7 Gotprurer T3 PcL Pramers

Use the list bar to highlight the print mode you want to
use Then, to apply the selected printer, chick

[Set As Default| You can also request the current
printer status through the [ Local Device Status|

The following table provides a brief description of the
Control Panel buttons and refers you to the page number
that provides detailed information about the available
features

lcon Description Page
Provides five shades of
—
@ density The default 1s 3 3
i 4
Density
Identifies the wait time
@ between last unit use 34
and start of unit power
Power Saving saving
= Used to configure the
g umt_ 34
Printer Setup
Identifies the port where
ﬁ your unit Is connected, a4 -
2 such as LPT1
Connect Port
i Displays the PCL Control
F[QL Pane! Menu
- 34
PCL Control
Panel
= Allows you to configure
[@S how DOS print job within
et Windows printing is to be 34
DOS Prnting processed
Cptions
= Allows you to share the
@q printer with Clients 35
Share Printer
—— Allows you to connect to a
F[ :l ] shared printer 35
Connect to
‘ Allows you to view the
Clients 35
Client Monitor
— Allows you to select
|€‘m whether you want the
ax Device Status window to 45
Status Report display when an errcr
Options OCCUrs
Allows you to print GDI
6
s 00 dpi configuration
page 26
Print

Configuration
Page
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The Local Queue is used to review the status of your
queued print jobs. For Servers, all pending print jobs are
local to the Server. For Clients, the Local Queue repre-
sents print jobs that have been queued to a remote
Server but are not yet transferred to that remote Server.

Note:

* Print job in the Local Queue will be displayed
only when “Use Panasonic KX-PS600 Print
Manager”’ is setected in the Panasonic
KX-PS600 GDI window ( v P. 36).

To display the Local Queue features, click the “Local
Queue” tab in the KX-PS600 Printer Console window.

a¢ K1-PEG0D Printer Consnle
[ Yow Symm Meeon Rpe fiep

[‘L:Tmm T pontocumn | i Log |
EE

i

pause [iRecume T shaw fgy Job Oty

T | jotr s {rormat] - Size] Time Jowner
[Spupoammprion — e L A

The Local Queue displays:

* the print job name .

* the format of the print job (GDI, PCL)
* the size of the print job in bytes

* the time the job was sent to the queue
* the owner of the print job

The job owner category is primarily applicable to the
Server.

The Local Queue displays the status of the job currently
being printed. For Clients, this status will display only
when the Client’s print jobs are being printed.
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Changing the Order of Print JODS ===

Both Servers and Clients support drag-and-drop jobs
within the Local Queue to change the job order in the
print queue. Drag-and-drop is available for jobs that
have not started printing. To change the order of print
jobs, perform the following steps:

1 Highlight the print job you want to change
the order with the mouse.

Efomene] S tume Gwmor 1
GO 80,774 Bytws 4 X0 41 P8 MFPOGPALA]

| 5} 06T Etes $IT1EPN  MIPGRVALKS
o %.5% Oyies A 12FM  MIPGQPAC

2 While holding the left mouse button down,
move the mouse arrow to the position you
want to drop the selected print job.

I [ {rormm] Stze|Tima Jowner ]
. oDl 80,774 Bytex A0 (0PM  MEPORPACKA
| GO 35,506 Brier 4 0220 PM  MFPORPACKA

41,062 Ervies 4 216K NERDRPACH

3 Release the left mouse button. The order of
print jobs will be changed.

o Heeme, I eree siellms_ Jowner ]
[l PowerPonl - BOOHDN PPT o B0774Bytes 4 MhATPM  WEPOQPACHA
[ Wrie - [Lintifled] GO RSB 43270 MFPOEFACHA

|
s
; % oo 41 D62 Bvie 4 32I6FU MEPGIOACK A

The following table provides a brief description of the
Local Queue button icons.

Ilcon Description

(a1 Allows you to pause printing.
[» Allows you to resume printing.
 epue

Allows you to add a print job to the print

ME gueue. Click the Add icon and select a
=] file (GDI or PCL 4.5 format) you want
to print.
(=3 Allows you to delete the highlighted
poks print job from the print queue.
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Lo aa

RemotelQuetc Rt <y 4

The Remote Queue 1s used to review the status of your
queued prnint jobs at the remote printer This queue 1S
primanly for Clients to review their print jobs Chents can
select from among the shared printers through the
“Show Print Queue for” list box

To display the Remote Queue features, chick the “Re-
mote Queue” tab in the KX-PS600 Prninter Console

The following table provides a brief description of the
Remote Queue button icons The Remote Queue dis-
plays the status of the job currently being printed

Icon Description
T Allows you to pause printing
Paure
{ > Allows you to resume printing
Regume

Allows you to add a print job to the print

window ) queue Click the Add icon and select a
£ KX-F3600 Printar Conmels 8 fite (GDI or PCL 4 5 format} you want to
mone | weeme | wiy | e print
T TR g i quenetor I o Allows you to delete the highlighted
E& IE:‘ '2@ ’E%P Q::m_,_,,mm I [w print job from the prnt queue
- - d ] Shaw Server
[iobHema = - [ Fosmat | —_Size[Time =~ — {owner j‘
A
] Print Servors [ Printer Status [ commants ]I
B The Job Log provides a historical log of the last 10 jobs

Show Print Queue for:

Aliows the Clents to select from among the shared
pnnters Clicking the list box wiil show you all available
shared printers

Show My Jobs Only
Clicking on the “Show My Jobs Only” check box will only
display your prnint jobs in box A

Show Server
Clicking on the “Show Server” check box will display the
box B This box will show you all the servers with their

status
Note: T h_"ﬁ#*—l

¢ Printjob in the Remote Queue will be displayed |
only when "Use Panasonic KX-PS600 Print |
Manager” 1s selected in the Panasonic '
KX-PS600 GDI window ( £5° P 36) !

. e = m e e - —— e

[

The Remote Queue displays

* the print job name

* the format of the print job (GD1, PCL)
e the size of the print job in bytes

* the time the job was sent to the queue
* the owner of the print job

The job owner category 15 primanly applicable to the
Server The drag-and-drop (reorderning the print jobs)
feature 15 not avallable in the Remote Cueue

queued for print To display the log of the-last 10 jobs,
click the “Job Log" tab in the KX-PS600 Printer Console
window

uf KY-PSEO0 Feintar Cansale &
I# Your Sepem pabmb Ay bew
T ocsouew | E&nﬁ?a\iu ™ obten octrol Panel
Last 10 Print Joba
[Time |Printed To [ sob Hema JForma | stuus |
1
L. ‘-
The Job Log displays

* the time the job was prnted

* the Server name (Printed to)

* the job name

* the format of the print job (GDI, PCL)

* print result (Status)

The Job Log 1s more useful for Clients in workgroup

environments, where there are multiple printers support-
ing differing printer characteristics

Note. l
* Print job In the Job Log will be displayed only |
i when “Use Panasonic KX-PS600 Print Man- ]'
| ager’ 15 selected in the Panasonic KX-PS600 |

GDI window ( 1= P 36) J
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KX-PS600 Printer Console
Menu Items

The KX-PS600 software provides the standard Win-
dows menu items which are available in most Windows
applications, as well as application-specific menu items.
Some of the menu items match the buttons available on
one of the tabbed displays. However, there are some
printer functions that can be accessed only through the
pull-down menu, such as the setting of print pricrity.

File

The File pull-down menu provides selection to exit your
application. This menu also provides selections to pause
or resume printing and add or delete a document to and
from the queue.

View

The View puli-down menu allows you to display all
servers with their status.

Settings

The Settings pull-down menu allows you to define the
defaultsettings for many of the following printer features.

Density O
The Density setting allows you to define the darkness of
the dots placed on the paper. There are five settings:
Level 1, 2, 3, 4, and 5. To make print lighter, set a lower
level. To make print darker, set a higher level.

Power Saving Mode E:E
With Power Saving Mode turned on, you can save
energy by instructing your unit to enter a low power
consumption mode when it is idle for 15 minutes.

For USA: To conserve energy and reduce operating
cost, the unit is equipped with a programmable power
save feature. The unit is factory set with the power save
feature turned on and programmed to 15 minutes to
comply with EPA’s Energy Star requirements.
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Printer Setup [@
The Printer Setup displays the primary printer settings
and configuration dialogue that also provides advanced
setting and features.

=
Connect Port |71
The Connect Port lets you select a different parallel port
for your unit. You can choose either LPT1, LPT2, or
LPT3. Your PC hardware configuration may limit your
individual opticns.

PCL Control Panel B
The PCL Control Panel displays the PCL Control Panel
window ( o= P. 43). This control panel provides config-
uration options for PCL printing from MS-DOS applica-
tions printed from the MS-DOS icon command line under
Windows.

DOS Printing Options J8s
The DOS Printing Options provides print emulation op-
tions for DOS printing.

You can select “Spool as PCL 4.5" or “Direct to Port” in
the Printing Mode list box.

Spool as PCL 4.5: makes the PCL Ccntrol Panel
settings effective.

Direct to Port: makes the DOS application’s settings
effective.

Some applications may not operate properly if the
“Spool as PCL 4.5 has been selected. In that case,
select “Direct to Port”.

Print Priority

Windows lets you run several applications at the same
time. This helps productivity but means you are sharing.
your PC resources among several activities.

The KX-PS600’s priority settings let you control the
priority of the printing activity relative to other applica-
tions running at the same time.

You can select High, Medium, or Low priority. Printing
at high priority produces output faster but may slow
down your system more than the other priority settings.
On the other hand, printing at lower priority lets your
other applications run faster but also means your docu-
ment will take longer to print.
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Network

The Network pull-down menu allows you to share and
connect to a network printer, Clients Momitor (if config-
ured as a Server) and change status settings, such as
print job notifications

Share Printer @
This selection I1s only avallable to Server configured
users When selected it will set the printer as Shared

Connect to @
This selection is avallable to Client and Server config-
ured users When selected «t will display a list of avail-
able printer Servers that can be selected

&

Client Monitor
This selection 1s avallable to the Server and provides the
capability to monitor the print activities of Clients using
the printer

Notify T
This selection 1s available to all users and defines the
various status selections and their display options
Selecting "Remote Status Report” allows you to see the
server's Printer Status window on the client

Change Name

This selection s avallable to all users and allows the user
to change the computer name You must exit and restart
Windows before this change takes effect The new
computer name must not exceed 15 characters

Run

The Run pull-down menu allows you to examine the
status of the printer and pnint a test page

* The “Close Interpreter” selection can clear the PCL
Printer icon after a DOS application has been printed
using the KX-PS600

35
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KX-PS600 GDI Mode

You can select the GDI Mode from an application, R R R R R R R R,

through the Control Panel’s Printer window, or through R
the Control Panel tab of the KX-PS800 Printer Console oK
window { o P 30) The Panasonic KX-PS600 GDI W S
window lets you select certain settings for your print job =
| Options
er Source | EERIET SNSRI,
To display the Panasonic KX-PS600 GDI window, per- n:::mi" e K
form the fOHOWIng - B @ Portrait Lopies ]7 l&b“ut
(3 Landscape Agsoluton [conam 17
B For Windows 3.1 or pover Sue T [} Use Panasomc KX PSED0 Prnt Manager
Windows for Workgroups 3.11 users: ® D I ‘
r._ij Last page on top {Reverse (hder)
[Leter 8172511 | 123
1 Double click the Parasonic KX-PS660 o Y
Tools icon in the Program Manager [Monarch 3 7/8 % 7 172w )
The Panasonic KX-PS600 Tools window will be I —
displayed
Notes:
2 Double click the Printer Console 1con. * After using features such as 2 Up/4 Up and
Go to step 3 Overlay in the GDI mode, you must revert back

to the original settings, otherwise the next print
Job will utilize the same features

B For Windows 95 users: * Some applications may not allow you to change
the settings through the Panasonic KX-PS600
GDI window In that case, you can change the

1 Sg:;g ’“':L%V?; 'T‘Taapg::;.? KX-PS600 settings using the Control Panel in Windows as
’ follows
Tools”

For Windows 3 1/
2 Click “Printer Console”. Windows for Workgroups 3.11 users:
1. Perform steps 1~4 of “From the Printers
in Windows” on page 29
2. Click In the Printers window
3. Make the desired changes

Click the “Control Panel” tab

For Windows 95 users

Click the Printer list box. 1 Click [ Start |, move the pointer to “Settings”
and click “Printers”

2 Double click the Panasonic KX-PS600
GDI icon

3. Chck “Printer” on the menu bar and click
“Properties” The selected printer's
Properties window will be displayed

4 Click “Details” tab

5 Click
The Panasonic KX-PS600 GDI window will be 6. Make the desired changes

displayed

Select “GDI>> Panasonic KX-PS600 GD1".

Click [@ {Printer Setup)

O 0 A W

{(continued)
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Paper Source :
Your unit has only one paper source, the Main tray.

Orientation
Choose Portrait (vertical) or Landscape (horizontal).

Paper Size
Allows you 1o select a different paper size.

Copies
Allows you to determine how many copies of the docu-
ment will be printed.

Resolution

Your unit provides two resolution settings:

600 x 600 dpi (dots per inch) and 300 x 300 dpi.

Higher resolution produces better quality output but

requires more time to print a document.

Note:

* Printing at 600 dpi will take longer than printing
at 300 dpi. In the effort of saving time, it is
recommended that you consider the following
when printing documents.

300 dpi: Text files/Files containing line
art/Drafts, proofs on non-final ver-
sions of graphics or photo inclusive
data files.

600 dpi: Final print of Graphic files, photos or

presentation files/Any file requiring
crisp, clear definition of very small or
very large fonts.

Use Panasonic KX-PS600 Print Manager
Selecting “Use Panasonic KX-PS600 Print Manager”
turns the Print Manager on when using GDI Mode. The
KX-PS600 Print Manager allows you to use:

* Last page on top (reverse order printing) (= P. 37)
* Duplex Printing ( 155 P. 38)
* Overlay ( =5 P. 39)

* Local Queue ( 1= P. 32) both in GDI Mode as well as
in PCL Mode

However, the print speed will be slower when the
KX-PSB00 Print Manager is activated.

‘Last page on top (Reverse Order)
-The unit normally prints documents in page number

order {i.e. page 1 first). Clicking on the check box at the
left of “Last page on top (Reverse order)” will instruct the
unit to print your output in reverse order.

OK
Click to make your changes take effect and return
to the previous screen.

Cancel
Click to ignore any changes you have made
and return to the previous screen.

Options

This button provides advanced GDI features, such as
duplex printing, and overlay. Also see ‘Usmg Options”
on page 38.

2 Up/4 Up
The unit lets you print 2 or 4 pages on a single sheet of
paper. Also see “Using 2 Up/4 Up"” on page 42.

About
Click [About] to dlSplay the program version and copy-
right information.
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Using Options

1 Make sure that “Use Panasonic KX-PS600
Print Manager” is selected in the Panasonic
KX-PS600 GDI window ( w=» P. 36).

2 Click [Options ] in the Panasonic KX-PS600
GDI window,

The Options screen will be displayed.

loptions ... g

] L

[ 11 Duplex Printing ——=—— —

[ a =

|| b Dpieing

| 9 ook Stre [_tmase__

| G Bepoastie | [y ]
| o]
_ r_.-!]ET-lmhucllun Parge - J E_ﬁ?j
Scaling Illm E 4

| 1 Print To File — —

J‘ ;r;j_FjleNnme IE_:\KXPSE[IU\DEFAULT_EDI H Browse I|
i :

Duplex Printing

You can print your file on both sides of the paper by first
selecting “"Manual Duplexing”, then selecting either
Book or Report. When performing this feature, follow the
instructions displayed on the screen.

Select “Print Instruction Page” to print a duplex instruc-
tion page at the end of the initial printing. This page
provides instructions and input paper orientation to show
you how to turn and reinsert the printed pages.

Scaling
Use “Scaling” to reduce or enlarge your output on the
printed page from 10% to 200%.

Print to File
If you select “File Name”, the output will go to a file
instead of the unit.

The printfile is stored in GDI format. Use the Add button

on the Local Queue of the KX-PS600 Printer Console
(= P. 32) to print from a file.
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Image

The Image feature lets you adjust the brightness and
contrast of your output. Also see “Using Image Options”
on page 42.

Overlay
The Overlay feature lets you overlay an image over any
document printed in GDI Mode (1= P. 39).

Default :
Click to restore all settings to their default

values.

Help

Click for detailed information about the
KX-PS600 Help system. Within the Help system, you
can select Contents to see a list of topics related to the
KX-PS600.
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Print Cover Page :
Select this feature to print a cover page on a separate
page before the remainder of the document.

\Using Overlay

You can use the Overlay feature to:
. ASC Company

* Incorporate your letterhead on the first page of a
business letter. '

* Print your logo at the bottom of each page of a set of
presentation slides. '

* Qverlay the word “Confidential” on every page of an
important document.

* Print a special cover page or trailer page ( o= below) | . Print Trailer Page .
for each print job. Select this feature to print a trailer page on a separate

page after the document has been printed.

1 Ensure that the “Use Panasonic KX-PS600

Print Manager” is selected in the Panasonic 9
KX-PS600 GDI window (6 P. 36). 0
j=4
@
2 Click | Options| . w
. o Print-Overlay

The Options screen w‘ﬂl be displayed This feature will overlay yourimage onthe pagesofyour A
( = P. 38). document, The effect is similar to printing your image on x
a transparency, then putting the transparency over your 3
. . document. D

3 Ensure that the “Manual Duplexing” in the Q
Duplex printing box is disabled. 8 Corpany o
= 8
4 Cick [Overiay . BT =
2 o
The Qverlay Options screen will be displayed. 3 1
c
L8
. * Select Qverlay 1st Page to overlay the image only on 8
gﬂ_@é:}:—h?e—it'\KXPSBBUWHINT o [ o the first page of the document, o
= S * Select Overlay All Pages to overlay the imageoneach  ©
I3} Piint Tsaiter Page [Corome ) page of the document. o
File Name: [CRXPSGOIPRINT GOL | Fe] * Select Ove.rlaly From to overlay the image on a range a
of pages within the document. o
[T} Print Dverlay ) 3
' File Name: |c;\xxpssuc|\gy£nmv.ﬁn Il a
' O
| () Dverlay 15t Page g
. [ (G) Oveilay All Pages . BTOWSE %

‘ _ After selecting Print Cover Page, Print Trailer Page, or

A | QjovedayFiom: 1 || To: [ 1 1 -
. L 7, m_;] l;j . Print Overlay, clicking will let you search for ™~

the GDI file in the file system.
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Overlaying and Printing
a Document

1 Using an application such as Paintbrush,
CorelDRAW or PageMaker, create and save
the graphic file that you want to overlay on a
document.

2 Verify the graphic by printing it, and
minimize the application.

3 Perform steps 1 to 6 of “KX-PS600 GDI
Mode” on page 36, however, after step 5 on
page 36, click “Set as Default”, before going

to step 6.
LS
) [ Options
Paper Souice I"'i'i"T""'ﬁﬁmuﬁ..mﬂ= [ 2uUpralp
‘ f (%, Partrait - Lopecs: |1‘ ‘_E ot
1 @ Lond Rgsomsion: [son oy 7]
Papol Sige s=———————————

4 Click [Options].

The COptions window will be displayed.

= ?
. I3) Print IsT::tuct—it)n Page— . s T
i I1|]U @
Sealing x
I]Plint To File =z -

[ZjEile Name  [C-ARXPSEOO\DEFAULT.ED! ||/ Gromee

5 Select “File Name” by clicking on the check
box at the left.

An X mark appears in the check box.

Ii ‘ (3 Beport Style .
: [3j Prnt Instiuction Page i -H_lalp
i Scaling 1{1—@ x

Piint To File

K {file Name! [CACPSGOODEFAULY 601 || Gramsa |
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10

11

Enter a new file name or the same file name as
used in step 1, but change the extension of file
name to GDI (>o<<.GDI) and click [OK]].

* The GDI file extension must be used to desig-
nate the difference between a GD! file and an
application file. Otherwise, the application file
will be overwritten by a GDl file.

Click in the Panasonic KX-PS600 GDI
window.

Minimize the KX-PS600 Printer Console win-
dow.

Double click the same application which you
minimized in step 2 and perform the print
operation. {Actually you will be printing to a
file, so no print-out will come from the
KX-PS600). Now minimize or close this appli-
cation.

Your created file will be stored as a GDI file.

Perform steps 2 to 6 of “KX-PS600 GDH
Mode” on page 36.

Select “Use Panasonic KX-PS600 Print
Manager” by clicking on the check box.

An X mark appears in the check box.

Panasonio KlPSﬁI] GI]I . il I V
|
;r ] oKk
B =
/ ™ Options
Paoes Gowce [ManTier ] T Aipitle
r {1 i

O Land R L.-Imdpi‘ \‘;l
—_— fusteli O

@ Portrait | Coviex: () Aot

r Paper Sige ==—=——

1
D) |
. — [Jj Lazt page on top [Revaise Oider]
[Lottar 8 172211 | 123
; B et

S| '1
1 3 4 PP
{[Monarch 3 w7 1s2i0 3} !
: -4

=

Use Panaspnic KA-PS 600 Print Managel

(continued)
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12 Click 16 Chck [Browse | .

The Browse window will be displayed
1 3 Deselect “File Name” by clicking off the

check box at the left. owe K&
File Name -
g - [ |
The X mark will be cleared from the check box _i%E;=:;J i
— Pt
Duplex Printing < s 1. r___uk__' wipage gdi ‘
. [onaei Duptouna, R CTT ;:;:::w:lﬁv;; ) 3 ‘ ID e
(jBaok Style _—W e e
' 1y N ! = Select Fite As  (J} Cover Page @Qvurl‘ay . gtymlm Page
! Q) Repont Style [ ! M“Wy - !
EfEn—nt instruction Page N m
. Help
L r
Scaling |100 4 o \ o 9
Pont To File = = = Fol
[CJFie Name, Ic \KXPSGO0\DEFAULT [;mvﬂm[ Tromre I 1 7 Double click on the dlrectory in which you '9._
e | saved your graphic file (GDI file), then select g}
‘ : the file and chick [OK]. Y
The™ selected-file will appear in a box In the
Overlay Options window %
14 ciek [Overiay] . %
wn
The Overlay Options window will be displayed 18 Cick In the Overlay Options window. &
o =
)
i - " . * v U
[ Punt Gover Page . N (e 1 9 Click in the Options windows. o
File Name ][I AKXPSBOAPRINT GDI " < §
| Prent Tradier Page R i 20 Click in the Panasonic KX-PS600 GDI &
Fils Name [C \KXPSE0D\PRINT 6D1 [ . window —
x . (T : =
G;Pnnlg:-' = e — S . S-
| FioNome [FWTEENVERUVED] o+ i} 21 Minimize the KX-PS600 Printer Console Q
' G Overlay 1st Page ;{ . T o Wlndow 9
(o] l]veltlay All Pagex - , g
4 - v " . . o
Grovedop o [T 1o [I_| ‘ . 22 Print the desired document from desired <
J = apphication.

The graphic will be overlaid on the pages of your
document

1 5 Click on the desired selection (s).

For example, select Print Cover Page
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Using Image Options

1 Click [Options | in the Panasonic KX-PS600
GDI window { 1z P. 36).

The Options screen wili be displayed.

2 Click [Image]|.
“The Image Options screen is displayed.

. pBrightness Conliol—r———

|l
|
*

i
|
1

o

ark Light
i [

Nomal 50

=1

e e
| Contiast Contro) —rem——————

| Smooth Sharp
o) L G
i 59

I Delaull ]

The Image Options screen lets you adjust the appear-
ance of your output. These adjustments only apply to
certain types of images and grayscales, not to text or
black line drawings.

The figure at the right of the screen will change as you
move the controls, giving you a rough idea of the effect
of your adjustments.

Note:

* This feature may not be effective for some
applications and the images scanned by
KX-PS600.

Brightness Control

Drag the Brightness knob or click on the arrows to vary
the shades of gray, making the image output appear
lighter or darker.

Contrast Control
Drag the Contrast knob or click on the arrows to make
the image output appear sharper or smoother.
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Using 2 Up/4 Up

1 Click[2UpHA Up] in the Panasonic
KX-PS600 GDI window.

The 2 Up/4 Up Printing screen will be displayed.

2Up/alp Printing [ %]

ok

T

|:-__jjglau Frame Border

* {1 up: prints normally.

* 2 up: prints two pages on one sheet of paper. In
portrait mode, the pages display side by side asin a
book.

* 4 up: prints four pages on one sheet of paper.

Draw Frame Border
If you click on Draw Frame Border, the unit will draw a
box around each page on the paper.
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KX-PS600 PCL Mode

You can select PCL Mode from an application, through
the Control Panel's Printer window, or through the
Control Panel tab of the KX-PS600 Printer Console
window ( ¢ P 30)

. PCL Control Panel .. . -

The KX-PS600 lets you printfrom MS-DOS applications,
but you must run the application from Windows or within
the DOS box under Windows Your urut also provides a
PCL Contro! Panel similar to the conventional PCL
printer's key panel for DOS PCL printing This allows you
to change printer settings for your DOS print jobs

To display the Panasonic KX-PS600 PCL Control Panel,
perform the following

B For-Windows 3.1-or
Windows for Workgroups 3.11 users:

1 From the Program Manager double click the
Panasonic KX-PS600 Tools icon

2 Double click the Printer Console icon.
Gotostep 3

W For Windows 95 users:

1 Click | Start |, move the pointer to

“Programs”, then to “Panasonic KX-PS600
Tools”.

2 Click “Printer Console”

Click the “Control Panel” tab.

4 Chck PCL Control Panel icon ( Ry ).

The Panasonic KX-PS600 PCL Control Panel
window will be displayed

Form Feed Rezet Help ok
Paper Source === j=—-—=== 1 Duentation =i mr]
b &) Portrant

|

o M (JLandscape _ Defaults

n “1 I About
- Coprer |1 E |
e Default Font

Font | Couner l‘ﬂ .
et

Size |1z \:[‘glyle [l Bold [J)itabe

Paper Size“=

@Jﬁapel D

Symbot Set |ROMAN 8 =] I
Rtk
[Letter 812 % 11 mn Y
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} Enyelopes EZ Top 0o Lelt 0_00_
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Bol nm« 111} @ Rught [0 0O
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¢ 19ydoyd

IMunaiCh37IBK7|’2 n Lﬂ

Form-Feed

Some PCL files do not include a form feed {(a command
to eject a page) at the end of the file, so the last page
will not be printed If this happens, you must click the
Form Feed button to print it out

Reset 4
Clicking the Reset button clears all data from the
printer's memory, including forms, macros, and un-
printed page images

Note that the Reset button does not change the printer
settings (onentation, paper size, number of copies, etc

)
to the onginal default values Click to restore

defaults
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Help ‘?

Click the Help button for detailed information about the
KX-PS600's Help System

(1oued j041u09) 70d) apo 10d 009Sd

Paper Source
Your unit has only one paper source Main tray

Paper Size

To select paper/envelope from within the Paper Size
box, first click on the paper/envelope icon Then select
the paper/envelope size that you wish to use

{(continued)
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Orientation -
Choose Portrait (vertical} or Landscape (horizontal).

Copies
Allows you to determine how many copies of the
document will be printed.

Default Font

Default font lets you select the default typeface, size,
and style for print jobs that are output from MS-DOS
applications run under Windows and for Windows PCL
print jobs. Both MS-DOS and Windows applications can
override the default font selection.

* Please note that you do not have access to Windows
TrueType fonts for MS-DOS print jobs.

Margins _

The Margins settings let you define the top, bottom, left,
and right margins for PCL print jobs. Please note that
DOS and Windows applications may override these
settings.

OK

Click for your changes to take effect. When you
exit, the PCL Controf Panel will load the PCL compatible
interpreter into your PC’s memory. This will save time
when you later print from MS-DOS applications under
Windows.

However, you can close the PCL compatible interpreter
and recover the memory, if you wish. Click the
KX-PS600 PCL Control Panel icon, then click

[Close |.

Cancel

Clicking will lose any changes you have made
to the PCL printer settings, and will exit the PCL Control

Panel without loading the PCL compatible interpreter.

44

Default

Click | Default | to restore all printer settings on the
screen to their default values.

About

Click to display the program version and
copyright information.
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KX-PS600 Device Status |

The Panasonic KX-PS600 Device Status program has A. Clicking this button will reduce the displayed
two primary functions: _ screen and the box G will disappear.

* To let you monitor the status of the local device. B. This box shows an error or status message and
* To alert you in case of a problem with your unit, such corresponding icon.

as paper out.
C. This box lists the name of the printer, the owner of

To display the KX-PS5800 Device Status window, the print job, the format of the print job, the name

perform the following. of the print job, and the page number for the job
currently being printed.

@ For Windows 3.1 or D.. The Pause button lets you pause printing. For

Windows for Workgroups 3.11 users: example, you can pause in order to cancel the pnnt

job from the appilication.

O
From the Program Manager double click the . E{
Panasonic KX-PS600 Tools icon. E. The Resume button lets you resume printing after &S]
you have paused printing, or after recovering from ity
an error situation. e
Double click the Printer Console icon.
‘Go'tostep 3. ‘F.  The-Delete button lets you delete the job currently
printing. ;
W For Windows 95 users: G. Thisbox displays a picture of your unit. [f a problem (-IU) :
has occurred, an arrow identifies'where the unit is §
Gick [Sart] movethe pointer o st The deply slso roudes comecve s6-
“Programs”, then to “Panasonic KX-PS600 ge. - 2
Tools™. - H. Ifyouneedadditional helpinresolvingtheproblem, & .
click [»]. This animated help feature will walk you  ¢n
2 Click “Printer Console”. through the steps required to get your unit running g '
once again. 5

3 Click the “Control Panel” tab.

4 Click [ Local Device Status | in the Printer
box. -

W DEFAULT - KX-PS600 Device Status
v
Printer: DEFALLT H
Job Owner: NiA
Format: Hia i
c +ob:(No Job)

Currem Page:0

WEE el FEe ] e ‘ ,
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Chapter4 Scanner Function

Before Scanning Documents

Acceptable Documents

The unit can scan documents that meet the following
conditions:

—Document width: 89 to 216 mm (3.5” to 8.5")

—Document length: 55 to 356 mm (2.17" to 14”)

—Effectiveé scanning width: 208 mm (8.19%)

—Document feeder tray: up to 20 pages of document
[75 g/m2 (20 Ibs.)]

—Document weight: 60 to 120 g/m? (16 to 32 Ibs.) for
continuous scanning, 60 to 135 g/m?2 (16 to 36 Ibs.)
for single page scanning

Minimum document size Maximum document size

—_ -
J’ 8ol £
. A E
o ' g
89 mm (3.5") e
(min. document guide width) I, |
216 mm (8.57)
Effective scanning width
: Docurmnent

inserting direction

e —

208 mm (8.19")

Unacceptable Documents

The following documents may cause a jam:

—Documents bound with clips, staples, or other similar
objects

—Documents on which ink, paste, or correction fiuid
that has not completely dried

46

Do not use the following types of documents. Make a
clear copy on a flat bed copier of these documents and
then feed the copy into the unit.

—Paper with a chemically treated surface, such as
carbon paper or carbonless duplicating paper

—Electrostatically charged paper

—Heavily curled, creased, or torn paper

—Paper with a coated surface

— Qriginal or precious photograph

—Small-sized paper such as a slip or voucher

—Paper with faint contrast between the print and the
background

—Paper with printing on the reverse side that can be
seen through the front

— Plastic or metal sheet

—Other than rectangular shaped paper (e.g. round or
triangular shaped paper)

Note:

¢ All literary, musical, artistic and typographical
works are copyrighted. While certain reproduc-
tion of copyrighted work may be permitted for
“fair dealing” e.q., for research, private study or
for the purpose of criticism or review, generally
reproduction of a copyrighted item is not permit-
ted without the permission of the copyright
owner.

Scanner Detector Program

The Scanner Detector program is required only when
scanning a document{s} to your PC. if you wish to use
other applications in Windows, it is recommended that
you deactivate the scanner detector (see below) as it
may have negative impact on their performance.

When you want to scan to your PC again, you must
reactivate the scanner detector by double clicking the
Scanner Detector icon in the KX-PS600 Tools, starting
the Destination Panel { e P. 47) or the KX-PS600
Document Desktop Program ( oze P. 50).

Deactivating the scanner detector:

Windows 3.1:

1. Click the KX-PS600 Scanner Detector icon.

2. Click “Close”.

Windows 95:

1. Click the Task bar using the right mouse button.
2. Click “Close” using the left mouse button.
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KX-PS600 Destination Panel

The KX-PS600 Destination Panel consists of 8 buttons
that let you perform different operations. All these oper-
ations except the copy operation can be performed
through the KX-PS600 Document Desktop ( t= P. 50).
However, using the KX-PS600 Destination Panel is
convenient when you repeatedly use the same opera-
tion. Before performing these operations through the
Destination Panel, make sure the KX-PS600 Destina-
tion Panel is displayed on the screen.

To display the KX-PS600 Destination Panel, perform the
following.

B For Windows 3.1 or
Windows for Workgroups 3.11 users:

From the Program Manager double click the
Panasonic KX-PS600 Tools icon.

2 Double click the Destination Panel icon.

B For Windows 95 users:

1 Click , move the pointer to
“Programs”, then to “Panasonic KX-PS600
Tools”.

2 Click “Destinaticn Panel”.

[3- PSE00 Destingtion Panel
A [[I "

7y Manager
button
" {EF P 49)

* The Fax ((© ) and OCR { @ ) buttons are
displayed only when the Fax and OCR
programs are installed (v P. 23, 60, 63, 64).
The designs of the @ and @ buttons vary
depending on the installed application.

B i e e T el |

Note: i

* If you want to use this destination panel fre- :
quently, it is recommended that you register it
in Windows startup group.

@ Scan to Desktop
The scanned documents are dnsplayed in the work-
space of the KX-PS600 Document Desktop as the
thumbnail image. The thumbnail is named “untitled-
x” automatically. Refer to page 50 for the KX-PS600
Document Desktop Program.

® Scan to PC and Printer
The document is first scanned and sent to your PC,
then it is printed through the KX-PS80Q0 Printer
Driver. Before printing you can edit, enlarge, reduce
or duplicate the scanned document on PC.

© Scan to FAX
The scanned document is faxed through the in-
stalled fax program.

@ Scanto OCR
The scanned text document is converted to the
editable text-document-through the installed OCR.
program (ex.TextBridge). Then the Word Processor
program is opened.

@ Scan to Microsoft Paintbrush (Paint)
The scanned documentis sentto Paintbrush (Paint)
application and the scanned graphic can be edited.

(® Local Copy

The scanned document is copied fairly quickly
when making single letter size copies at a print
resolution of 300 x 300 dpi. However, when you try
to scandocuments at a higher resolution, more than
one copy or attempt to scan to a legal size, the
copying process slows down. '
To expedite this process you must install an op-
tional RAM Expansion board ( tz P. 83) referring
to the following table.

1 MB RAM board | Making a copy with the quality
setting at 300 x 300 dpi wil be
fast. However 300 x 600 dpi

setting will be slow.

2 MB RAM board | Making a copy with the quality
setting at 300 x 600 dpi and
paper size setting at legal will be

slow.

4 MB RAM board | Making a copy with any setting

will be fast.

[ Note:

* |t may be required to install an optional
RAM Expansion board ( iz P. 83) to copy

.a complicated document such as photo.

I D
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Scanning Documents 4 Click your desired button on the Destination

Panel (@ -).

To perform a scanning operation using a Destination Panel

button (@ - = P. 47), follow the steps below. _
. 5 Fan the stack of documents and tap it on a

level surface to avoid document jams or
1 © Open the output tray (top cover). skewed scanning.
® Extend the paper output support by
sliding it upward.

Notes:
* A maximum of 20 sheets of 75 g/m? (20
Ibs.} can be inserted at a time in the

Extend the document feeder support by dgcument feeder tray.
holding its top edge and sliding it upward. _* It is recommended to count the number

of documents to confirm that it matches
with the total number of documents dis-
played on your PC after scanning.

@ Insert the documents in the document
feeder tray with the printed sides facing
up and the top of the documents first.

® Adjust the document guides to the width
of the documents.

Note:
* When you load the legal size document,
open the document cutput support.

A dialog box will be displayed on the screen to
prompt you to start or cancel the operation

{ ©F P. 62). In this dialog box you can change
the settings according to your requirements.

Note:

* |t “Enable Auto Scanning” has been
selected (“V" mark is checked) from
3 Display the KX-PS600 Destination Panel the selections menu of the Manager
(1= P.47). button ( o= P. 49}, the documents are
scanned automatically and no dialog
box will be displayed.
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7 Chek to start operation.

An operation will be performed depending upon 0
the button you clicked in step 4 on page 48 The Manager button { C#7] ) on the Destination Panel
has the following items

Notes: * Preferences
* If you click the (® button (Scén to —Selecting “Preferences” will display the Preferences
PC and Printer) dialog box { t= P 62) In this dialog box you can
A dialog box will be displayed where you change the settings of the Destination Panel button
can change the prnt settings If you
need to make further changes, follow * Device Status Monitor ( 12 P 45)
the steps below —Shows the Status Monitor
i Chek in the dialog box
2 Click [Options] in the Setup dialog « Enable Auto Scanning

box The KX-PS600 GDIwindow will
be displayed ( 15* P 36)
¢ Ifyouclick the © button (Scan to FAX)

——Selecting “Enable Auto Scanning” will automatically
start scanning operation when you insert the docu-
ment(s) in the document feeder tray after clicking a

The Fax send dialog box will be dis- Destination Panel button (55 P 47)
played and you can designate the re-
celver

This selection 1s effective even if the Destination i
Panel or the Document Deskiop is not displayed on
the screen (g P 50)

Il

Notes:

* As you click “Enable Auto Scanning”, the
displayed menu of selections disappears If

R you wish to confirm whether this selection
has been enabled, click the Manager button
again and you will see a “ v " mark to the left
of “Enable Auto Scanning”

* You can also select “Enable Auto Scanning”
from the KX-PS600 Document Desktop by
choosing “Enable Auto Scanning” from the
Options menu , ;

!
|

0.
-
-0
e
—
F -9

* Options

—The *Destination Panel Size" option allows you to
change the Destination Panel button size setting

—Selecting “Destination Panel Always Visible” will
always display the Destination Panel on the front
screen

—Selecting “Show Tooltips” will show the name of
the Destination Panel button when the pointer 1s on
the button

L
[sued uoljeunsaqg 009Sd-XM
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KX-PS600 Document Desktop Program

The KX-PS600 Document Desktop is a versatile pro-
gram that lets you organize, edit, annotate, and redis-
tribute your scanned documents without ever switching
programs.

Note: ]

* If you have installed the KX-PS600 software '

" (= P. 22), the KX-PS600 Document Desktop |

program has also been installed at the same |

e time. !

To display the KX-PS600 Document Desktop window,

perform the following or it will be automatically displayed

when performing the “Scan to Desktop” operation from
the KX-PSB00 Destination Panel ( i P. 47).

M For Windows 3.1 or 7
Windows for Workgroups 3.11 users:

From the Program Manager double click the
Panasonic KX-PS600 Tools icon. Then
double click the Desktop icon.

B For Windows 95 users:

Click [Start!, move the pointer to “Pro-
grams”, then to “Panasonic KX-PS600
Tools”. Then click “Document Desktop”.

Toolbar

Menu Bar

Viewing Modes (g P. 52)
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|
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L U' Tijen - “J
ooy | e 1P qgb ol P aoiagberiel, 32,158 bynln
Control Center Workspace Status Bar

The KX-PS600 Document Desktop window is divided
into five areas. Below is a description of each.
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Workspace

The workspace displays the documents in the program,
allowing you to view, manage, and edit them. [t differs
in appearance and performance depending on the view-
ing mode ( 1 P, 52).

Menu Bar
The menu bar contains all the commands available in
the program. If a command is not available because of
the viewing mode or other conditions, it is grayed out.
Many frequently used commands are also available in
the toclbars.

Toolbar

The toolbar contains frequently used commands for
easy access. The tootbar changes depending on which
viewing mode you are in. The following table provides a
brief description of all the icons in the program and when
they appear: :

- Viewing
leon Description Mode
_ Provides information about Thumbnails,
@ the selected documentin the | List
workspace
Document
Information
B Copies the selected Thumbnails,
OB document to the same folder | List
Duplicate a
Document
: Turns the document 90 Thumbnails
i@ degrees counter clockwise
Rotate Left
90 Degrees
_ Turns the document 90 Thumbnails
f@ degrees clockwise
Rotate Right
90 Degrees
_ Locates all documents with Thumbnails,
@ names matching the search List
criteria you define
Find
Document

{continued)
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Icon Description V;::&gg - leon Description Vﬁ;vér;g
Combines all selected Thumbnails, — Shows the next page in a Page
™ documents into one multi- List - Cp multi-page document. '
page document. Disabled if Disabled if already showing
Clip less than two documents are Next Page |thelastpage - '
selected : _ Allows you to go to a specific | Page
Separates combined Thumbnails, '.D page in a multi-page
documents back into single- | List ' document. Disabled if the
page documents. Disabled if Go to Page |current documentis a single-
Unclip All a multi-page document is not page document
selected _ Shows the previous Page
_ Separates the currently Thumbnails, :c | document in the current :
; m selected page in a multi-page | List folder. Disabled if the
: document from the document Previous currently shown document is
Unclip One | and makes it a single-page Document | the first one
document. Disabled if a multi- _ Shows the next documentin | Page
page document is not (] | the current folder. Disabled i
selected
- the currently shown -
Armranges all thumbnails Thumbnails Next document is the last one
RRR neatly in the workspace Document o
: .| Allows you to go to a specific | Page
Hearrangg Fﬁ' documgnt in tr?e current )
Thumbnails. ‘folder: Disabled:if only one
Opens the Preferences All modes Goto docurnent occupies the
E% dialog box where you can Document | current folder
—= change the scan settings and .
Preferences | other program features
(=3
( , P 9\2)_ , Control Center
. Prints a listing of the current | List - The top part of the Control Center varies depending on -
g% folder's contents, including the viewin d P
document names, last saved g mode { = P. 52). In-the Thumbnails and
Print List dates, sizes, number of List modes, it displays all the folders in the program. By
pages, and comments clicking on a folder, you can view its contents in the
(e P.52) , workspace. In the Page mode, it contains a toolbox
Increases the magnification Page where you can select tools for annotating or modlfylng
@ by one level. Disabled if at the currently shown page. :
the highest magnification . ) ‘
Zoom In The bottom part of the Control Center contains the
) Reduces the magnification by | Page Linked Application Tray ( 1z P. 60}, By_dra_lggmg docu-
@ one level. Disabled if at the ments from the working area to the appropriate program
J lowest magnification icon, you can send a copy of the selected document to
Zoom QOut that program.
: Resizes the currently shown | Page
@ page to exactly fit the width of
the workspace. Thisis a
Fit Width good setting for wide Status Bar
documents The status bar changes dependmg on program activity.
_ Resizes the currently shown | Page It shows the information about the program status and
@ page to exactly fit the height workspace contents.
of the workspace. This is a .
Fit Height good setting for long
documents
Shows the previous pageina | Page
multi-page document.
Disabled if already showing
Previous the first page
Page
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Viewing Modes

The KX-PS600 Document Desktop has three viewing
modes: Thumbnails, Page, and List. This section briefly
describes each mode and how the workspace changes
when it is active.

Thumbnails Mode

The Thumbnails mode is the default mode for the pro-
gram. The KX-PS&00 Document Desktop always starts
in this mode. All documents in the current folder appear
as miniature thumbnails. You can create and delete
folders, combine and uncombine documents, and per-
form editing tasks other than annotating and adding or
deleting blocks of data.

Selected documents appear with a color border, To
select all the documents in the current folder, choose
“Select All” in the Edit menu. To select multiple docu-
ments individually, press the CTRL or Shift key as you
click on each document.

When a combined document appears in the Thumbnails
mode, a scroll bar appears below its thumbnail showing
the total number of pages and the current page. The
name of the combined document matches that of the
first page.

List Mode

The List mode shows the names of all documents in the
selected folder along with the last saved date, file size,
number of pages, and comments you added. This mode
is most useful if you want a quick overview of the
documents in the KX-PS600 Document Desktop. A Print
List icon in the toolbar enables you to print the informa-
tion shown in the working area.

Selected documents are colored. To select all the doc-
uments in the current folder, choose “Select All" in the
Edit menu. To select multiple documents individually,
press the CTRL or Shift key as you click on each
document.

" KX =PI Documen IJrul\lop
,p...-.- Lin Yom lswe g iane

CN— BbDI@I. lﬁain,] 2 [@

thsu 0/%/% Porasomc 30357 | Sample Documen 2

. v -
| Reacy ot oo D Dapad o2 Gotweigr) L0 by

Page Mode

The Page mode is ideal for detailed viewing and modi-
fying documents. You can only show one page atatime,
but can zoom in up to 200% (twice the actual size}, or
down to 25% (one-quarter the size).

You can also make changes to the document. In addition
to the standard editing commands, a toolbox in the
Control Center provides tools for highlighting, erasing,
annotating, adding text, and copying the current docu-
ment.
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Switching Viewing Modes

You can switch modes by:

* selecting the desired viewing mode from the drop
down list in the toolbar.

* choosing Thumbnails, Page, or List from the View
menu.

* double cficking on a thumbnail to switch to the
Page mode.

* double clicking on an icon in the List mode to
switch to the Page mode.

* double clicking on a document in the Page mode
to switch to the Thumbnails mode.
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Deleting a Folder
To delete a folder, perform the following

_Organizing Documents .

The KX-PS600 Document Desktop allows you to orga-
nize your scanned images by grouping them in folders 1 Choose “Delete” from the Folder menu
You may create as many folders as you hke in the
KX-PS600 Document Desktop and name them anything

you like with two exceptions The names Deskpad and 2 Select the folder you want to delete from the
Trash are special folders created by the program drop down list box
* Deskpad Is the default folder 3 Click .

* Trash 1s a special folder that stores documents you
wish to delete By storing them here, you can still
recover them If you change your mind To perma- 4
nently delete these documents, choose “Empty Trash”
from the Options menu Or in the Trash section of the
Preferences dialog box { == P 62), set the automatic
trash emptying guidehnes

Click to return to the main window.

_Managing Documents .

The KX-PS600 Document Desktop offers many ways for
you to manage your documents You can search for
documents that are not currently visibie on “screen,
rename them, add comments, and do several other
things to make your workplace more manageable

Adding.a-Folder
To add a folder, perform the following

1 Choose “Add” from the Folder menu. .
Searching a Document

To find a document, perform the following

Enter a name for the folder in the Add Folder

dialog box
1 Choose “Find” from the Document menu or
The maximum length of a folder name 1s 30 click @l in the toolbar
characters Any combination of alphanumeric ’
characters, including a hyphen (-}, a slash {/}, .
and aspace { }1s allowed when naming folders 2 In the Find Document dialog box, enter the

name, creator name or created date of the
document you are looking for.

3 Chck ) Note-

* To find similarly named documents or if
you do not remember the full name of

dopisaqg uswnooq 009Sd-XM

Renaming a Folder the one you want, include the wild card
To rename a folder, perform the following character () in the search
{ Select the folder you want to rename 3 Click )

All documents matching the search cntena ap-

2 Choose “Rename” from the Folder menu. pear in the Search list box

3 Enter the new name In the To: box of the 4 Select the one you want
Rename Folder dialog box.

4 Cck [OK. Click to view In the Page mode.

(siuswinaoqg Buibeuepy pue BujziuebiQ ‘sapopy Buimalp)

. (continued)
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Renaming Documents
To change the name of the document, perform the
- following.

1 Select the document you want to rename.

2 Choose “Rename” from the Document
menu.

Enter the new name in the To: box.

4 Ciick [OK].

Creating a New Document

After creating a new document, you can copy/cut an
image and/or text from other documents and paste in
the new document { ez P. 57, 58).

To create a new document, perform the following.

1 Choose “New” from the Document menu.

2 In the New Document dialog box, select the
size, resolution.

The unit of the size can be changed by selecting
“UNIT™.

3 Click l0K].

Note:

* You can create a new document from a
part of a document by using the clip-
board.

1. Copy a desired part of a document
within Page view (g P. 58).

2. Return to Thumbnails view. '

3. Choose "New" from the Document
menu.

4. Click “Clipboard” button.

5. Click “OK” button.

54

Viewing Document Information
To view the document information, perform the follow-

ing.
1 Switch to the Thumbnails or List mode.

2 Choose “Info” from the Document menu or

The Document Information dialog box opens
where you can view the current document sta-
tistics, add or modify the comments, and change
the name. .

Moving Documents
You must be in the Thumbnails or List mode to move
documents. There are two methods (A, B) to move them.

Method A:

Select and drag documents from the work-
space to the desired folder in the Control
Center.

Method B:

1 Select the documents you wish to move
( = “Thumbnails Mode” on page 52).

2 Choose “Move Toe” from the Document
menu.

3 Select the desired folder from the drop down
list in the Move Document dialog box.

4 Cick [OK].

Duplicating Documents
To make a copy of the selected document, perform the
following.

1 Switch to the Thumbnails or List mode.

2 Choose “Duplicate” from the Doucment
menu or click @l in the toolbar.

A new document named “untitied-x" (where x is
the next available document number) will be
displayed in the workspace.
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Deleting Documents
There are three methods (A, B, C) to delete a document.

Method A:

1 Drag the document to the Trash icon.

9 Click (Yes].

Method B:

1 Select adocument and choose “Delete” from
the Document menu.

9 Click .
Method C:
Select a document and press the Delete key
on the keyboard.
9 Click .

To permanently remove the documents from the
KX-PS600 Document Desktop, choose “Empty
Trash” from the Options menu. Until you choose
“Empty Trash” you can recover any documents
in the Trash folder.

Arranging Documents
To neatly arrange the docurmnents, perform the following.

1 Switch to the Thumbnails mode.

Choose “Arrange Documents” from the View

menu or click [BBB] in the toolbar.

GO0

2

The KX-PS600 Document Desktop repositions
all thumbnails in the current folder to appear
neatly in the workspace.

Multi-page documents help you clean up your desktop
and ensure that documents that belong together stay
together. They can be modified just like single page
documents. You can create and ungroup multi-page
documents in the Thumbnails and List modes only.

Creating Multi-page Documents
There are two methods (A, B) to create multi-page
documents.

Method A:

1 Drag and drop one document into a target
document.

The target document remains the last page.
Each additional document you drag goes on top
of those already in the group.

Method B:

1 Select all the documents you want to group
{ ©zr “Thumbnails Mode” on page 52).

2 Choose “Clip” from the Document menu or
click in the toolbar.

Navigating Through Multi-page Documents
There are two methods (A, B) to navigate through a
multi-page document.

Method A:

1 In the Thumbnails mode, use the scroll bar
below the thumbnail to navigate through the
document when the document is selected.

Method B:
1 In the Page mode ( 15 P. 52), use the page

tools ( |Q|, ]Q.-I, ﬁl)in the toolbar to

display different pages in a multi-page doc-
ument.

55
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Ungrouping Multi-page Documents
To remove a page from a multi-page document;

1 Select the document and bring the page you
want to remove to the top.

2 Choose “Unclip One” from the Document
menu or click @l in the toolbar.

The removed page is named “Untitled-x" (where
X is the next available document number).

To ungroup all pages in a multi-page document:
1 Select the document.
2 Choose “Unclip” from the Document menu

or click || in the toolbar.

Each page is named “Untitled-x" (where x is the
next available document number).

56

Editing Documents

You can edit documents in the KX-PS600 Document
Desktop to improve their appearance and emphasize or
hide certaininformation. Most of the editing functicns are
available only in the Page mode.

Rotating Documents
You may rotate documents in the Thumbnails and Page
modes.

1 Select the document you want to rotate.
2 Choose “Rotate” from the Image menu.

Click “Left 90 Degrees” or “Right 90
Degrees” in the submenu to rotate the
document left or right by 90 degrees.

Notes:
* In the Thumbnails mode, you may click on the

/@ or @ in the toolbar to rotate the

document left or right by 90 degrees.

* |f you rotate a multi-page document, only the top
page will be rotated.
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yr ’w‘?‘

WakinglAnnotations Rekake

Annotations to documents include adding or erasing
information in the document, copying blocks to the clip-
board for pasting elsewhere, and highlighting or affixing
notes to the document All these actions are controlled
by the toolbox in the upper portion of the Contrel Center
in the Page mode

THKX-PSE00 Decument Deskiap
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Tool Purpose
Select a note, highhight mark or added text
L to move, delete or resize Double click on a
note or text to edit the text
Pickup

- Drag a transparent color over a portion of
(] the document to emphasize the area
Choose “Color” from the Edit menu to select

Highhghter | the highhight color Use the pickup tool to
resize and reposition existing highlights
1 | Remove information from the document
4 Highlighter and Stick Note cannot be
removed
Eraser

= Paint a solid color area over the document
) containing text If you move this area the
text moves with it Choose “Color” from the

Sticky Note | Edit menu to set the color of the note
, Add text or annotations to the document

AN Choose “Fonts” from the Edit menu to
select a font style and size

Text
Select an area to cut, copy, or crop to the

+ cliphoard

Cutter

Highlighting
To highlight a portion of the document, perform the
following

1 Show the page to which you want to add
highhghts.

2 Click | @

3 Choose “Colar” from the Edit menu
) ]

Basic Colors

F"Ii_ll_ll:‘l JE]

4 Select a highlight color and click

5 Move the pointer to the beginning of the
document portion you want to highlight

6 Drag the mouse over the area you wish to
highhght

To remove the highlight, click the desired high-
hght by using the Pickup tool and press the
Delete key on the keyboard

Erasing
To erase Information from a document, perform the
following

1 Show the page from which you want to erase
information

2 Chck | ¥

3 Drag the mouse over the area you wish to
erase
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Sticking Notes
To place a note on a document, perform the following.

1

OO &~ WODN
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Show the page on which you want to place a
note.

Click | =

Choose “Color” from the Edit menu.
Select a highlight color for the note and click
OK|.

Choose “Fonts” from the Edit menu.

Y |
' Font; Ford style: Size:
| | [Bokd |} 12 ok
T
S IT‘FM-E 0] ==
A N ":J [Corce |
I Techeucal o L ;
Tesminal : ﬂ H o
1 %Li'nesNewFlmn !_‘ sl :
A = | 1 i
- | oo ’i" Bl .l
T Wigdogs2___ I |
?Sarple:.-f-:e-.-.—f-—— — ]
‘I AaBbYyZz Ji
L= =
Seyipt:
Wes_lem_ ) i ll
"
[l

Select your desired font, style and size for
the text, and click [OK |.

Click on the document where you wish to
place the note and begin typing. You may
press the Enter key for multiple lines.

When you finish entering text, click | *

You can resize or move the sticking note by
clicking it and dragging as follows:

resizing: Click ablack square onthe frame with
the left mouse button. White holding down the
mouse button, drag the black square to your
desired location and release the mouse button.

moving: Click anywhere on the note’s text with
the left mouse button. While holding down the
mouse button, drag the note to your desired
location and release the mouse button.

Adding Text
To add a piece of textto the document, perform the
following.

S W N =

Show the page to which you want to add text.

Click | &

Choose “Fonts” from the Edit menu.

Select your desired font, style and size for
the text and click [OK].

Click on the document where you wish to add
text and begin typing. You may press the
Enter key for multiple lines.

When you finish entering text, click .

Cutting, Copying, and Cropping

You can cut, copy, or crop pertions of the image and
paste them semewhere else. To cut, copy, or crop,
perform the following.

1

Show the page containing information which
you wish to place on the clipboard.

Click | ™

Drag your mouse over the area which you
wish to place on the clipboard.

Choose “Cut”, “Copy” or “Crop Image” from
the Edit menu, depending on whether you
wish to retain the selected area in the current
location.

Later you can choose “Paste” from the Edit
menu to paste the contents in the clipboard.
The pasted area can be moved around by drag-

ging.

{(continued)
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Note:

¢ Every time you cut or copy portions of
300 x 600 dpi image, the warning mes-
sage appears on screen. If you do not
want this to appear again, check “Do
not show this message” option. This
message will not appear until Docu- 1 Choose “Import Fax...” from the Document
ment Desktop window is closed and menu.
opened again. :

" Importing WinFax Document

To import a document from the WinFax ( cz P. 60)
application, perform the following. This function is not
activated in Windows 85.

- 2 Select a document from the WinFax fax list
in the Import Fax dialog box.

Importmg/Exportmg _f 3 Click [OK].

The KX-P5600 Document Desktop creates a
new document.

Supported file types are: prx, bmp, tif, pex, gif, ipg.

To import a file, perform the following.

1 Choose “Import” from the Document menu.

2 Select the file you wish to add to the
KX-P5600 Document Desktop workspace
from the Import Image File dialog box.

7 19idoyn

3 Click [OK].

The KX-PS800 Document Desktop creates a
new document named “untitled-x" (where x is
the next available document number) containing
the information from the selected file.

To save a document as a file, perform the following.
1 - Choose “Export” from the Document menu.

In the Export Image File dialog box, assign a
file format and destination for the file.

3 Click

Note

* If a document scanned at the resolusion
of 300 x 600 dpi is exported with a file-
type other than prx and imported directly
into other application, the vertical side of
the document may become twice as long
as the actual size of the document.

4 i s e Rt oy, et e e
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Working with Linked

Programs

The KX-PS600 Document Desktop allows you to print,
fax, and send documents to other applications without
leaving the program. The KX-PS600 Document Desktop
automatically creates links to programs already installed
in your computer. Icons for linked programs appear in
the Linked Application Tray in the Control Center. These
are the applications the KX-PS600 Document Desktop
links automatically.

T KX PG00 Decument Deshlap
[ T e

e —
| —

o Tran

Linked pid oot |
Application Tray L ot e

o0
|

* WordPerfect (5.2, 6.0)

* Microsoft Word (6.0, 7.0)
* AmiPro (3.0)

* Write *

* WordPad *?

* NotePad *3

* WinFax Pro (4.0, 7.0)

* At Work Fax *4

* Eclipse Fax (6.0)

* SmartComFax (1.0)

* FaxWorks (3.0)

* Mail *3

* Microsoft Excel (4.0, 5.0, 7.0)
* Paint *6

* Microsoft Fax *7

* Paintbrush *8

* cc:Mail (2.0)

* Exchange *¢

Notes:

* *1 =3 and *8 are included in Windows 3.1 soft-
ware as standard.

e 1 +3 4 *5 *7 and '8 are included in Windows
for Workgroups 3.11 software as standard.

® +2 *3 *6 *7 and *? are included in Windows 95
software as standard.
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Sending a Document to a Linked Program
There are three ways to send a document to a linked
program:

* Select the document and click the program icon in the
Linked Application Tray.

* Drag the document to the program icon in the Linked
Application Tray.

* Select the document and choose “Send to” from the
Document menu. Then choose the linked program to
which you want to send the doecument,

Note:

* If a document scanned at 300 x 600 dpi is sent
to an application like a paintbrush, the vertical
side of the document may become twice as long
as the actual size of the document depending
on the application.

Adding a Link
To create new links for other type of software such as
image editing, perform the following.

-

Choose “Applications” from the Options

menu.
The Application Link dialog box will be
displayed.

Install Applications:

a

¥
[|=]

[ |
[ Btete, |
([~ Modfy,
s |
Canca™ |
. e
2 Click [Add].

The Add Apgplication dialog box will be

displayed.

li

1

i Titte: I e

: File Name: I— . |l‘ ][—“ﬂrouse._. l

, File Format: | windows BMP 1j°.bmal

l

| @
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3 Enter a title for the program in the title text
box and a complete path of the program’s file
name in the File Name text box. (If you do not

know the path or name, click to

select a program.)

4] Select a file format that the linked program
can recognize from File Format drop down
list.

-

Notes:

* |If a proper file format is not selected,
link will not work. Refer to the manual
of the application to confirm the file

' format.

* Some applications may not be recog-
nized by your KX-PS600 because of a
specific file format. In this case, link is
not assured.

5 Click to close the Add Application
dialog box and return to the Application Link
dialog box. ‘

@ Click to save the settings and return to
the main window.

Modifying an Existing Link
To change the description, icon or execution file name
of a linked application, perform the following.

1 Choose “Applications” from the Options
menu.

2 Select the application you want to modify

and click .

3 Change the settings of the Modify
Application dialog box accordingly and click
OK;.

4 Click in the Application Link dialog
box to return to the main window.

Deleting a Link
To delete a linked application from the KX-PS600
Document Desktop, perform the foilowing.

1 Choose “Applications” from the Options
menu. : ; :

Select the application you want to delete.

Click .

Note
¢ The KX-PS600 Document Deskiop does not
delete the program from your computer.

PP U

Using OCR

When you drag a scanned text document to a word
processing program, the KX-PS600 Document Desktop
automatically converts it to editable text using the Opti-
cal Character Recognition (OCR), and transfers the
editable text to your word processor. Once inside the
word processor you can edit and save documents ac-
cording to that program’s procedures. For best results
when sending a document to a word processor, make
sure you scanned it in the Text mode with the quality
setting at 300 x 300 dpi (1= P. 62). After using OCR if
the quality of the text is not optimal, change the density
setting { = “Scanner Preferences” on page 62) and try
again.

e i e o s e e

Note:

* The KX-PS600 Document Desktop cannot
convert documents sent to word processing
programs unless the Text Bridge (OCR)
program ( o= P. 23) is already instalted in your
computer.

61
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Optimizing the Document Desktop and Destination Panel

The Preferences command under the Options menu of
the Document Desktop ( uz» P. 50) and under the Man-
ager button on the Destination Panel ( gz P. 47) allows
you to set various application or device options installed
in your computer. This section explains the Preferences
dialog box in detail to help you choose the best settings

for your work.

To display the Preferences dialog box, choose _

“Preferences” from the Options menu or click on
the toolbar of the Document Desktop, or click “Prefer-
ence” from the Manager button ( @ ) on the Destina-

tion Panel.

Scanner Preferences
Click the Scanner icon under categories.

Prelerences []
Catagories: ook
7] Semnags -« -— — -y
B | o S
R e
P r ‘
Detkicp R oyl |
@ 4 - Option - — - }
Prinipt T Aurto Dasgackls l’
Fax
Micro¥on Fax “v |

+ Document

* Quality

+ Default
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Text: Scanning a text and/or black-
and-white graphics document in the
Text mode produces the optimal quality
output (When performing OCR, you
must use this mode).

Photo: Scanning an image document
in the Photo mode produces the optimal
quality image output.

Text & Photo: Scanning a document
with text and/or black-and-white graph-
ics, and image in the Text and Photo
mode produces the optirmal quality out-
put.

However, your system’s memory will be
utilized thereby reducing its capacity.

The finer image will be produced by
selecting 300 x 600. But it takes longer
to process and requires more disk
space.

Returns you to the default settings;
Document: Text, Quality: 300 x 300,
Density: Normal

* Density Allows you to adjust the brightness of
the image. If the scanned image is too
dark, select Light or Lighter. If the
scanned image is too light, select Dark
or Darker,

* Auto Click on the check box to automatically
Despeckle remove black dots appearing at the bor-
der of the page scanned in the Text

mode.

Desktop Preferences
In the Preferences dialog box, click the Desktop icon
under categories.

:t P
Cnlegones: o
j o - d |
i Q Tl I Dinplay When Scasning . Concel
] Scaner F AntoClg When Scanmihg
B e oo
| Besilop )
g 'Al F Groy Scole View i DPW Dismap
Prt . [ - Page View Detadh ————— -
g] C Actunl Sige
Fax I GF wm J
& ! [ Calor
Mhcrogon Fas = | —

* Display Click on the check box to display the
When scanning dialog box when scanning
Scanning  documents. '

= Auto Clip  Click on the check box to automatically
When combine multi-page documents when
Scanning  scanned.

* Gray Scale Click onthe check box to view black and
View white documents as grayscale docu-
ments. This command enhances the
displayed image quality in every scan

mode.

* Actual Size Select this option to display the docu-
ment in its actual size when changing
view mode to the Page mode.

* Fit Width Select this option to display the docu-
ment in the workspace when changing
view mode to the Page mode.

« Color Press this button to show the dialog box
in which the color of workspace is se-
lected.
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Printer Preferences
In the Preferences dialog box, click the Printer icon
under categores

- F Dusplay Print Dialog Box ————
Q 1 Cancel
Scomar F Shaw On Apphication Tray
= =
Desitop
_—)
Far
MicrosonFes 3

Fax Preferences (Link Automatically)

In the Preferences dialog box, click the Fax icon under
categones This Fax Preferences dialog box appears
only when the installed Fax program can be finked
automatically ( gz P 60} The design of the Fax icon
varies depending on the program

Categones

7] 2 Show On Apphcation Tray ,—_
g | Cancal
A

Fax SoftWare s m-ishes
Scannsr

& |

 Datalt

Micrasoft Fax
Destiop |
ﬁ | C Specrhad By Usar
Priniter Mirtosntt Fax id
& ([ BotAs bafaar
Fas

v —

&

Mrusalt Fas L

= Display Print

Click on the check box to display the

Dialog Box print dialog box when printing

* Show On Click on the check box to show the
Application Prnnter 1con in the Linked Apphcation
Tray Tray

+ Setup Click to open the standard Windows

Print Setup dialog box

Fax Preferences (Link Manually)

in the Preferences dialog box, chick the Fax icon under
categones This Fax Preferences dialog box links the
Fax program which cannot link automatically

{= P 80)

Categones ™ oK

I Ehaw On Applicenian Tray —
T Cancel

* Show On Click on the check box to show the Fax
Application con in the Linked Application Tray
Tray

* Fax Select the Fax pregram from the pro-
Software grams nstalled on your PC by chcking

“Specified by User” and you can set the
program as a default program by click-
ing the Set As Default bution

E-Mail Preferences
Inthe Preferences dialog box, click the E-Maul icon under
categories

’reterences [x]

(13N

oo

1 Cotegones.

= P Show On Applicatian Tray

Erte Formal

{Windaws BWP 1~ bmg) -]

0
=
o]
O
—
<
Y

4
Scanner
=]
Deshiop
&

&
& |
« ShowOn  Click on the check box to show the Fax
Applicatton icon in the Linked Application Tray
Tray
* List box Select the fax installed in your system

v

from the list box

Click on the check box to show the

Application E-Mail icon in the Linked Application
Tray Tray

* File Listthe file format to use when attaching
Format a document to an E-Matl message
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Scanner Function

Word Processor OCR Preferences

in the Preferences dialog box, click the Word Processor
OCR icon under categories. The design of the Word
Processor OCR icon varies depending on the program

installed in your system.

Gaengoriae: 7 Show On Application Tray
- - Word Processor . - — == -1 =2 e o
@ '} 1 £ dwito Detact I—[ Gancet
Far !
o
“= ! .
1 Swlacted by e R
Micros ol Fax i ' it r—!ml
&B \‘ w\windows \write exe '
| MS Exchange oo o
E} ! Dutpat Hile Formet
‘;M ] [Winggws wirarwRi) =}
i H Languags.
LR :|_

e Show on
Application
Tray

* Word
Processor

* Qutput File
Format

* Language

Click on the check box to show the
Word Processor OCRiconinthe Linked
Application Tray.

Select the Word Processor installed in
your system that you wish to launch
after recognition.

Listthe file format to use when attaching
a recognized document to a Word
Processor.

Select the language of the document to
be recognized.

Paintbrush {Paint) Preferences
In the Preferences dialog box, click the Paintbrush
{Paint) icon under categories.

Prelerences [ ]
Catagorins: _ v On ebcaben oy
muﬁh- : Eile Farmat: .r—Cunwi
- [Windows OWP 1 ¢ bmg) Kl
Msgu\qs
L4
Word
Y
"i"_"%'?"f""l;l
* Show On Click on the check box to show the
Application Paintbrush (Paint) icon in the Linked
Tray Application Tray.

* File Format
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The file format selected from the File
Format list will be sent to Paintbrush
{Paint).

Trash Preferences
in the Preferences dialog box, ¢lick the Trash icon under

categories.

| & Hone

i

Prompt To Empty Trash — = = = oo

| on Tating
| Gan E:E Ducumuni{s} In Trngh

£ On Qocumani{s} Okisr Than

Trash

e

F fihaw On Application Teoy

* None

» On Exiting

+ Oni#
Documents
In Trash

= On Documents
Older Than
# Days

* Show On
Application
Tray -

Click on the check box not to delete
documents in trash automatically.

Click on the check box to automatically
delete all documents in the Trash when
you quit the KX-PS600 Document
Desktop.

Click on the check box to automatically
delete the documents in Trash when it
reaches a specific number of docu-
ments.

Click on the check box to automatically
delete documents in Trash that are
older than a specified number of days.

Click on the check box to show the
Trash icon in the Linked Application
Tray.
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Local Copy Preferences

The settings of “Local Copy” can only be changed when
“Preference” is selected through Manager button on the
Destination Panel { 1z P. 47).

In the Preference dialog box, click the Local Copy icon
under categories.

[pretercnces B
ik = - Show Dm Destiaation Panel
B i| e B =
gy || e fEmrEne
word | Sptings s ey
A I e e — |
" || b @3
| o
Al
* Show On  Click on the check box to show Local
Destination Copy icon on the Destination Panel.
Panel

» # Copies  Set the number of copies.

» Paper Size Select the paper size of the document.

* Document Text: Scanning a text and/or black-

and-white graphics document in the
Text mode produces the optimal quality
output, o
Photo: Scanning an image document
in the Phote mode produces the optimal
quality image output.
Text & Photo: Scanning a document
with text and/or black-and-white graph-
ics, and image in the Text and Photo
mode produces the optimal quality cut-
put.

+ Quality The finer copied document will be pro-
duced by selecting 300 x 600.

* Density Allows you to adjust the brightness of
the copied document. If the copied doc-
ument is too dark, select Light or Ligh-
ter. If the copied document is too light,
select Dark or Darker.

% Note:

! When you try to scan a document at 300 x 600
! dpi, more than one copy or attempt to scan to \
! a legal size, the copying process slows down

L {1 P. 47), |

TWAIN Program

R T mET
ing-aniima

M:Mr;q !

Using a TWAIN-compliant application, you can access
KX-PS600, scan an image and transfer it to your docu-
ment,

The steps below assume that you have attached your
KX-PS600 to the PC and successfully installed the
TWAIN program ( vz P. 23).

r

T

! Notes: !
| * Close "KX-PS600 Scanner Detector” when '
using the TWAIN program because the |
: “KX-P5600 Document Desktop” operation ‘
‘ has priority over the TWAIN program. E
' o The operation of selecting the TWAIN program l

vary depending on the application. Refertothe |
: application’s manual for specific instructions. —J

b -

1 Run Windows 3.1 or above.

2 Run a TWAIN-compliant application (such as
Adobe Photoshop). Refer to the Appli-
cation’s manual for specific instructions on
using the Application.

3 Choose “Seléct Source” under the File
menu.

The Select Source dialog box will be displayed.
This step may vary depending on the TWAIN-
compliant application you are using.

Selcurce ] . ] ‘
Sources:

Panagonic KX-PS600 1.0

| Cancel

4 Choose “KX-PS600” and click Select |.

{continued)
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Scanner Function

5

Choose “Acquire” under the File menu.

The KX-PS600 Scanner Options window will be
displayed. This step may vary depending on the
TWAIN-compliant application you are using.

Panasonic KX-PS5600 Scanner Options

Document : [Te)diSlundald) El l! ‘OK l
i T Concal
| Quatity: 300x300 = ]
§ Dofoun

* Document Text: Scanning a text and/or black-

Nb_te:

* Make sure that “Text" is selected with the
bundled TextBridge software. '

and-white graphics document in the
Text mode produces the optimal quality
output.

Photo: Scanning an image document
in the Photo mode produces the optimal
quality image output.

Text & Photo: Scanning a document
with text and/or black-and-white graph-
ics, and image in the Text and Photo
mode produces the optimal quality out-
put.

However, your system’s memory will be
utilized thereby reducing its capacity.

T

* Quality Allows you to select 200 x 200 or 300 x

300.
Select 200 x 200 if you are using a fax
software.

Note: _ o . .
® Twain driver cannot be used at 300 x 600 dpi. '
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+ Density Allows you to adjust the brightness of
the image. If the scanned image is too
dark, select Light or Lighter. If the
scanned image is too light, select Dark
ofr Darker.

» Default Returns you to the default settings;
Document: Text, Quality: 300 x 300,
Density: Normal

6 Insert the document you want to scan into
the document feeder tray with the printed
side facing up.

7 Click and the KX-PS600 starts scan-
ning.

* Clicking anytime during scan-

ning will stop the scanning process.

At this point, you can edit or save the scanned image
using the application’s commands.
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TextBridge Software .

Installing the TextBridge
Software

Installing TextBridge software is a two-phase process.
First, you install the software files. Second, you run a
scanner setup program to link TexiBridge to your
scanner's system-level or TWAIN source driver.

Installing the Software

Toinstall the TextBridge software, insert the TexiBridge
disk 1 into disk drive A and perform the following proce-
dure.

B For Windows 3.1 or
Windows for Workgroups 3.11 users:

1 From the Program Manager, click “File”.
Then click “Run...”. :

2 Type A\SETUP.

3 Click [OK]. Goto step 4.
B For Windows 95 users:

1 Click [Start ], move the pointer to “Settings™,
then to “Control Panel”.

2 Double click the Add/Remove Programs

icon, then click [Install...].
3 Click [Next>], then click [Finish |.

4 click [Continge) .

Adialog now displays the TextBridge installation
directory on your hard disk. The default is:
CATXBRIDGE

Click [ Continue].

A dialog appears enabling you to choose the
OCR language packs you want to install.

Click on the checkbox for each language
pack to be installed.

You must select at least one language pack in
order for TextBridge to perform QOCR.

Click [Continue].

The Setup program begins installing the
TextBridge software files.

. Follow the_ instructions on the screen to in-

stall the TextBridge files from TextBridge
disks 2 and 3.

When the setup program has installed all nec-
essary files from the installation disks, it displays
a dialog informing you so. '

Click [OK].

The setup program automatically creates the
TextBridge OCR program group (TextBridge,
Scanner Setup, Release Notes) and opens it on
your screen. '
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Linking TextBridge to
TWAIN Source Driver

To use TextBridge with KX-PS600, run the Scanner
Setup program. Scanner Setup links TextBridge to your
KX-PS600 TWAIN source driver.

To link the TextBridge to your KX-PS600 TWAIN source
driver, perform the following.

M For Windows 3.1 or
Windows for Werkgroups 3.11 users:

1 In the TextBridge OCR program group,
doubile click the Scanner Setup icon.
Goto step 2.

B For Windows 95 users:

In the TextBridge OCR falder, click “Scanner
Setup”.

2 Choose “Select Source” from the File menu.

The Select Source dlalog will be displayed.

Select Source 1.5 "
Sources:

Panasonic K{=F3600 1.0

Select ]

I

‘ Cancel ‘

3 Highlight the Panasonic KX-PS600 source
driver.

4 Click to complete the selection.

Choose “Exit” from the File menu.

You are now ready to use TextBridge with your
KX-PS600.
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Remowng the TextBndge
Software

If you need to remove the TexiBridge software, perform
the following.

B For Windows 3.1 or
Windows for Workgroups 3.11 users:

{1 From the Program Manager click the
TextBridge OCR icon.

2 Choose “Delete” from the File menu.

A message asks you: Are you sure you want to
delete the group ‘TextBridge OCR'?

Click [Yes .

From the File Manager, click on the
txbridge directory.

5 Choose “Delete” from the File menu of the
File Manager.

The Delete dialog will be displayed with the full
pathname of the txbridge directory highlighted.

Click [OK].
Click |Yes to All|.
Click |Yes to All|.

From the File Manager double click the
Windows directory.

© 0O ~N O

This displays the list of files in the directory.
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10

11

12
13

Scroll to display the following files:

txbridge im

Delete each file by clicking on it, pulling
down the File Manager File menu and click-
ing “Delete”.

This displays a Delete dialog box
For each file, click in the dialog box

Click at the Confirm File Delete dialog
box

The files are deleted

B For Windows 95 users:

1

Click “Taskbar ” from Settings.

This displays Taskbar Properties dialog

Chck the Start Menu Programs Tab, then

chick | Remove...

Select the TextBridge OCR folder and click

[ Remove |.

Click at the Confirm Folder Delete
dialog, then close the Remove
Shoertcuts/Folders dialog.

Click

From the Windows Explorer, select the
TextBndge folder and press the Delete key
on the keyboard.

Click at the Confirm Folder Delete
dialog

10

Click | Yes to All| at the Confirm File Delete
dialog.

From Windows folder, select the Txbridge.im
and press the delete key on the keyboard.

Chick at the Confirm File Delete dialog.
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Chapter 5 Stand Alone Copier Function

Making Copies

Any acceptable documents ( i P. 46) can be copied.

There are three methods:

s Using the Local Copy butten on the Destination
Panel ( > P. 47) _
Allows you to change the COPY settings; kind of
document, quality, density, paper size and number of
copies.

* Using the Scan to PC and Printer button on the
Destination Panel (©F° P. 47)
Allows you to change the print and scan settings.

* Pressing the COPY button on the unit (Stand
Alone Copier Function)
Allows you to make only single copies with unchange-
able settings; Letter size paper, Text(Standard) or
Text&Photo document, 300 x 300 dpi quality, Normal
density.

1 © Open the output tray (top cover).

® Extend the paper output support by
sliding it upward.

2 O Lift the document output tray.
@ Insert the paper all the way down into the
paper tray.
® Adjust the paper guides to your paper
size.

For detailed information on how to load the
paper, refer to steps 2 and 3 on page 17.

The height of paper should not exceed the limit
mark on the paper guide, orit may cause a paper

jam.
Limit maﬂ
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Extend the document feeder suppott by
hoiding its top edge and sliding it upward.

4 © Insert the documents in the document

feeder tray with the printed sides facing
up.

@ Adjust the document guides to the width
of the documents.

* A maximum of 20 sheets of 75 g/m2 (20 Ibs.)
can be inserted at a time in the document
feeder tray.

* If the documents start scanning automatically,
this indicates that the “Enable Auto Scanning”
selection has been enabled. Disable this se-
lection { gz “Manager Button” on page 49)
and reinsert the document in the document
feeder tray.

Notes:

s ff you want to copy legal size paper, an
optional RAM expansion board needs
to be installed { = P. 83).

* You can copy by pressing the COPY
button even if the PC Scanning window
will be displayed.



Stand Alone Copier Function

5 Press the COPY button.

¢ |f you press the COPY button for less than 2
seconds, your document wilt be copied in the
Text(Standard) mode If you press it for more
than 2 seconds, your document will be copied
in the Text & Photo mode

0 COPY button

Notes.

* To interupt making-coples, press the
COPY button again

* Athin stnpe may be printed on the edge
of paper because of the document’s
shadow

Mmoo
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Chapter 6 Care and Maintenance

Cleaning the Unit
Periodic cleaning of the unit is recommended. The fre- o o
quency of cleaning is dependent upon the environment Internal , )

in which the unit is used. You should clean the unit:

* at least once a month. . 1 Turn the power OFF.
* when you install & new Process Unit.
* when the scan quality has deteriorated. See steps 1
and 5~7 of “Internal”. 2 Open the left cover and remove the Process
* when the print quality has deteriorated. See steps 1~4 Unit by grasping the green labeled tabs.
of “Internal”. _ Before cleaning the inside of the printer, allow

the fuser to cool (about 5 minutes).

1 Turn the power OFF.

2 Clean the cover with a soft cloth.
Use any mild commercial cleaner.

Cautien: ‘;
* Do not use benzine, thinner, aerosol cleaners,

or any abrasive powder to clean the cabinet. ® The unit must be turned CFF prior to cleaning.

* Do not expose the Process Unit to direct sunlight
or antificial light for more than 5 minutes.

* Do not touch the green drum surface of the
Process Unit.

{continued)
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' Care and Maintenance

3 Clean the following areas (paper path) with a 5 © Close the paper output support and the
dry cloth or a cotton swab. output tray (top cover).
i ‘ & Remove the document feeder tray by
With a dry cloth slightly raising and pulling it out of the
® Pinch roller printer. -
* Feed roller

» Transfer roller
* Paper chute {Paper dust)

With a cotton swab

* Carefully wipe the tungsten wire and the laser
unit mirror by sliding a cotton swab from end
to end 4 to 5 times.

Laser unit mirror

et

aF
/

Open the scanner door.
Clean the glass with a dry soft cloth.

Clean the following areas with cloth
moistened with isopropyl rubbing
alcohol.

®@®e

Pinch roller

| Transfer roller
(Transfer unit)
* White plate

® Pinch rollers
* Feed rollers
® Pickup roller

Tungsten wire | * Pad
(Transfer unit) / / '
\ 0
N 9
1 *]
§e)
~
D
-y
Pickup roller White plate o

4 Close the left cover.

Pad

Hun ay3 bulues|d

7 Close the scanner door.
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Troubleshooting

Many problems associated with the unit can be traced to improper setup or cabling. The following table will assist you

in identifying and correcting some of the more common problems.

Trouble

Possible Cause

Corrective Action

LED not blinking

N¢ AC power

Check power cord.

Power on but unit not
printing data

Interface cable not connected

Check interface cable.

The interface cable is connected
to PC via printer buffer or selector

Disconnect the printer buffer.

Dark stripes or stains on Dirty paper path Clean paper path ( ez P. 73).
paper
Vertical line on paper Dirty paper path Clean paper path ( iz P. 73).

Dirty tungsten wire

Clean tungsten wire (1= P. 73).

Dirty laser unit mirror

Clean the laser unit mirror { gy P. 73).

Scratch on drum

Replace Process Unit.

Scratch on fuser roller

Replace fuser. The unit requires service by an
Authorized Panasonic Service Center.

Very faint print

Toner may be empty

Shake the Process Unit or refill the toner in the
Process Unit ( tz P. 83).

Print density not adjusted

Select the proper print density ( &= P. 34).

Transfer unit { 1=z P. 73) is
defective

Replace the transfer unit. The unit requires
service by an Authorized Panasonic Service
Center.

Horizontal faint grey
stripe(s) appear on the
printout

The Process Unit was exposed
to antificial light, or direct sunlight
for more than 5 minutes

These stripes will automatically disappear after a
few hours.

Paper jams occur
continually

The paper size selected through

the GDI Mode or PCL Mode and

software application are different
from the installed paper size

Select the correct paper size through the GDI
Mode ( i P. 36) or PCL Mode (= P. 43) and
application.

After removing the
jammed paper, the
ERROR indicator still
blinks

Paper fragment(s) remains in
the unit

Move the sensor lever to the upright position by
using an object iike a ball point pen. The
remaining fragment(s) will be ejected.

Ejected paper is caught
between the paper output
support and the output
tray

There is a space between the
output tray and the paper output
support

Slide the paper output support down, then
extend it again to remove the space { o Step 1
on page 17).

Paper jam has occured

Follow the instructions displayed on the screen. If stains appear on the back of the
printed paper after a paper jam is cleared, it is recommended that you run several

test prints.
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Trouble

Possible Cause

Corrective Action

Printout 1s skewed

Paper tray 1s not installed
properly

Install the paper tray correctly { o P 15)

Paper guides are not
adjusted properly

Adjust the paper guides correctly (= P 17)

Document feeder tray 1s not
installed properly

Install the document feeder tray correctly (1 P 15)

Document guides are not
adjusted properly

Adyust the document guides correctly ( 1= P, 48)

Printout is ragged

Replace the screen fonts with TrueType fonts because screen fonts may be selected

To show only TrueType fonts in

For Windows 3 1/Windows for
Workgroups 3 11

1 Double click the Main icon in the

Program Manager

Double click the Fonts icon

Click

EEXES

exit-the-TrueType dialog box
6. Click

Double click the Control Panel icon

Select “Show Only TrueType Fonts
in Applications”, and click to

applications, follow the procedure below

For Windows 95

1. Double click the My Computer icon
Double click the Control Panel con
Double chick the Fonts icon

Chick in the View menu
Select “TrueType Tab”

Select “Show only TrueType fonts in the
programs on my computer”, and click

SR

7 Ciick to restart Windows

Dirty pattern, black, or
white bands appear on
a copled document

The paper or document path
15 dirty

Clean the paper and document paths ( 15° “Internal” on
pages 72~73)

Scan/Copy quality has
detenorated

The document path 1s dirty

Clean the document path ( 1= steps1 and 5~7 on
pages 72~73)

The document contained
texts and images 1s
scanned/copied with Text
mode

Scan/Copy the document with Text&Photo mode

Documents rmisfeed
frequently

The document path 1s dirty

Clean the document path ( &= steps1 and 5-7 on
pages 72~73)

The settings chosen
through an application
are not effective

Close the application, perform the printer settings in the KX-PS600 Console window,

.jand open the apphcation again

DOS application file
cannot be printed

Operation in the background
1s not effective

Start the DOS application from the MS-DOS prompt of
the Windows or follow the instructions on the next page

Printing operation from
DOS in Windows 95
cannot be performed

A dniver other than KX-PS600
1s spooling the data sent from
DOS -

Select the “Properties” of any driver other than
KX-PS600 from the “Printers” of the “Settings” in
Windows 95 Then select the “Port Settings” from the
“Details” and disable the “Spool MS-DOS print jobs” by
chicking off its check box

9 Jaj,dbqg

Scanning operation
cannot be performed

Scanner Detector program
may be closed

Start the Scanner Detector program from “Panasonic
KX-PS600 Tools”, open the Destination Panel (1= P

through PC 47), or the KX-P3600 Document Desktop ( = P 50)
Converting operation The document i1s scanned Scan the document after changing the setting to
through the TextBndge | with 300 x 600 setting 300 x 300

has failed

The document scanned
upside down

Scan the document downward

{continued)
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Trouble Possible Cause Corrective Action
Cannnot print to other | Scanner Detector is open Close the Scanner Detector ( r= P. 46) and try again.
printer
Copy operation cannot | Left cover or scanner door is | Close the left cover and the scanner door.
be performed by open
pressing the COPY Paper jam has occured Remove the jammed paper after openning the left cover
button and scanner door, then close both covers.
The unit may have entered Copy operation will start automatically after warming up.
the Power Saving mode
( vz P. 34)
The document is not inserted | Insert the document correctly in the document feeder
correctly tray ( ez P. 48).
Process Unit is not installed Install the Process Unit (1 P. 14).
Application link does Improper file format is Select a proper file format referring to the application’s
not work selected for the application manual.
Cannot access the Scanner Detector program Close the Scanner Detector program.
KX-PS600 using a may be active
TWAIN-compliant KX-PS600 TWAIN driveris | Select the KX-PS600 TWAIN driver, refer to the
application not selected application’s manual.

Ch

Printing a DOS application (For Windows 3.1 or Windows for Workgroups 3.11 users):

eck that your DOS icon is tagged “Exclusive”. If it is, then you must change it to non “Exclusive”. You may check

this by following the instructions listed below.

POb~

QN>
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Double click the Main icon in the Program Manager.
Double click the PIF Editor icon.
Click “File” and “Open”.
Select the PIF file name corresponding to DOS application.
If the DOS application has no PIF, create PIF by performing @ ~ @ :
@ Double click the Windows Setup icon in the “Main” group.
{® Click the “Options™ menu and “Set Up Applications”.
© Create PIF by following the instructions on the screen.
@ Perform steps 2~4 above, go to step 5.
Check that “Exclusive” is not selected.
Select “Save” in the “File” menu.
Exit from the “PIF Editor”.
Perform the print operation.
If the application cannot be printed, the application window may be spread on full screen.

Press (Alt) + to reduce the window size, then print.

Note for (i80386 CPU) PC users:
* Slower printing may be encountered if using a 1386 processor. For test print, it may take about 10 minutes on

some PC at 600 dpi, to overcome this please change resolution to 300 dpi. The recommended configuration
for faster printing is a i486 running at 50 MHz (or greater), and 8 MB of memory.

Note for Windows 95 users:

* After cancelling a print job in Windows 95, sometimes further printing may not be possible. If this happens,
minimize the application you are printing from, return to Program Manager and click “My Computer” icon, click
“Printers” icon and click the “Panasonic Printer” icon for the printer you are using. You will find the cancelled
printer file. Please click “Purge Print Job” in “Printer” of menu bar on Windows 95. This cancelled file will print.
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Error Indication

Indicators
*
LI O L}/ @4 Possible Cause | Recovery
TONER/
ERROR |READY | PROCESS
UNIT
Output tray (top cover) 1s not open Open the output tray (top cover)
Paper jam has occurred Remove the jammed paper, then open the left cover
and close it
Paper tray 1s empty Load paper in the paper tray and press the
COPY button (<2 seconds)
Left coveris open Close the left cover
RAM overflow or overrun has Press the COPY bhutton (<2 seconds) !f the error
occured continues, see *4 below
Document top sensor does not Open the scanner deor, remove the jJammed
' 0 0 sense after start document feed document and close the door Then reinstall the
document
Document top sensor keeps active | Open the scanner door and remove the lammed
after feed maximum page length document Then close the door
(640 mm)
Scanner door 1s open Close the scanner door Remove the document if it
15 In the unit
Memory full occurs when making a | Press the COPY button (<2 seconds) Then try
local copy again making the local copy by clicking the
Destination Panel button with the following settings,
Qverrun occured during local co
9 PY " Document Text, Quality 300 x 300 and # Copies 1
If you can make a copy, see ** below
. If the error continues, service by an Authonzed
Panasonic Service Center 1s required
O s Toner may be empty Refhil the toner or shake the Process Unit
= D (= P 83)
«1 | Toner may be empty and the life Install a new Process Unit when the toner supply I1s
a O [ ] cycle of the Process Unit has depleted 0
expired =2
o
- <1 x2 | The life cycle of the Process Unit pod
o u has expired . @
‘. O (] Process Umit 15 not installed Install the Process Unit { g P 14) o
3 Internal errors If the ERROR indicator is Iit, turn the power off for a
- O 0 few seconds then on again
If the error continues, service by an Authornzed
Panasonic Service Center s required
m On W blinking (fast - with an interval of about 1 second)

off Y blinking (slow — with an interval of about 2 5 seconds)

*1 You still can refill the toner, but it 1s recommended that you replace the Process Unit as soon as possible to maintain
maximum print quality

*2 You can print additionat pages until the toner supply 1s depleted, but 1t 1s recommended that you replace the
Process Uinit as soon as possible to mamntain maximum prlnt guahty

*3 Vanes depending on the condition

*4 |t 1s recommended that you install an optional RAM expansion board ( > P 83)

uonedIpu} 10113
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Error Messages '

B Memory:

H Disk:

System is low on memory. Please quit one or
more applications to increase available mem-
ory. Not enough memory available.

These messages indicate that your PC does not have
sufficient internal RAM. To remedy the probable cause
try executing one of the following opefations.

a) Close open applications to increase available
memory.

b) If connected to a network, disable network drivers

¢) Increase virtual memory { = P. 21).

Scanning or image editing may not be able to work
properly if the allocated virtual memory is insufficient in
Windows. Since it requires a considerable amount of
memory to process the image, try increasing your PCs
virtual memory to the maximum aliowable. If it is still ot
sufficient you may have to delete some unnecessary
files or programs. The recommended virtual memory
requirement is 12 MB (if your software and printer re-
quires virtual memory as well then more may be neces-

sary).

d) Restart Windows.

If the application is terminated inadvertently due to a
malfunction or unstable condition, there may be a pos-
sibility that this procedure will not release the specified
allocated memory. In this case, restart Windows.
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Disk full. Please delete some unused data and
" Empty the Trash.

This message indicates that there is inadequate free
disk space to allocate newly scanned images or dupli-
cated thumbnails. Please note that each thumbnail re-
quires considerable amount of disk space and
thumbnails in trash also takes up disk space. Empty
trash by selecting “Empty Trash” in “Options” menu

{ 1z P. 50).

If this error continues, then try to delete unnecessary
thumbnails. Hf it is still insufficient, detete unnecessary
files by using File Manager (Windows 3.1} or Explorer
(Windows 95). First delete the temporary files under
\KX-PS600\TEMP directory. Please note that the
Desktop sometimes makes temporary files under this
directory (refer to next section).

Disk problem, cannot save file

Fail to save scanned data

Error at file creation, cannot duplicate page

Make sure that your system has enough free disk space
to allocate newly scanned images or duplicated thumb-
nails. If this error continues after securing enough free
disk space, then check that the KX-PS600 directory is
not write protected or physical disk is not damaged.




Care and Maintenance

B Link:

TextBridge recognition failure!

This error message indicates failure to execute the
Xerox TextBridge OCR program. Please make sure that
TextBridge is installed correctly, and that the files under
TextBridge directory (specified at TextBridge instalia-
tion) are not corrupted or deleted. If this error continues,
reinstall TextBridge by running SETUP.EXE on
TextBridge disk 1 of 3 and follow the procedure on the
display.

Document counter has reached its limit, -
please clean up your temp files!

When linking (drag & drop the thumbnail over the appli-

cation tray) to another application a temporary-file is
- created under the directory “C:\KX-PSB00\TEMP". The
image data is then transferred to the designated appli-
cation. Please delete temp files from this directory when
you encounter this message, delete files not needed

from the desktop

“Application name” execute failure

This error message appears on the Desktop due to
failure to execute the application specified in “Add Ap-
plication” dialog after using drag & drop thumbnail.
Please make:sure that the specified application is not
deleted, renamed, or moved to ancther directory.

“Canceling. Page too complex for selected
mode. Error code: 706"

This error message indicates failure to execute the
Xerox TextBridge OCR program.

A document containing a lot of data cannot be-handled
by TextBridge completely. Rescan the document at 300
% 300 dpi if it was scanned at 300 x 600 dpi, or with Text
if it was scanned with Text & Photo or Photo.

- M Other:

“Printer port is not available ! Do you want to
wait [Y/N]?”
Printer is busy. Do you want to wait?”

This message is displayed when attempting to perform
an operation such as printing while the unit is carrying
out another operation like scanning. Basically two oper-
ations cannot he performed at the same time because
each operation-uses the printer port,

if “Yes” is selected, the operation you are attempting will
be performed after the current operation is finished.

If “No” is selected, the operation you are attempting will
be canceled.

LUnabie to open Winfax log file .

Desktop can retrieve images from Winfax log file. To'do
so, select “Import Fax...” from Document menu. When
this message appears, make sure that the Winfax is
properly installed and that all necessaty files under the
Winfax install directory are not missing.
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Care and Maintenance

B OCR Linking
(Non-Auto Detect Applications)

1. Click “Preferences” icon toolbar appearing right
below the Menu bar (or click “Preference”, from the
“Options” drop-down menu on the menu bar}.

2. Select “Word"” from the “Categories” menu ("Word"
was automatically detected in this example).

3. Select “Selected by User” to enter the directory
where your word processor is located.

4. Browse throughfolders, select the path and file name
and click "OK”.

5. Click “Output File Format” and from the pull-down
menu select the file format for the OCR-ed document
selected in step 4.

6. Click “OK”. This closes the dialog box.
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B How to Save Disk Space

Understanding how the OCR process works with KX-
PS600 is important. When a document is dragged into
an OCR supported application from the KX-PS600 Doc-
ument Desktop, the following process occurs:

1. The criginal document on the KX-PS600 Desktop is
not altered in any way.

2. Before the OCR application runs; a conversion is
made from the original file on the desktop to the file
format supported by your OCR application. This new
file is saved in the CAKX-PSG600\TEMP directory.
There are two methods to follow so as not to have
duplicate files on your hard drive.

Method 1

Rename the file on the KX-PS600 Desktop to a desired
name prior to dragging it to the OCR supported applica-
tion. The file will still be saved in the CAKX-PSE0ATEMP
directory, however, when the QCR application opens, it
will now use the file name you specified on the KX-
PS600 Desktop. This will eliminate the need for you to
rename the file from the OCR application; causing the
duplication of files.

Method 2

Drag the desired fite to the OCR application. When the
application opens, save the document with the name .
you desired and the path. Once the file has been saved,
you can then delete the duplicate file from the CAKX-
PS600\TEMP directory.



Care and Maintenance

Repacking Instructions

It is highly recommended that you keep the original

carton and ALL packing materials. Should you need to 3 Remove the document output tray by twist-
transport or ship your unit, please follow these instruc- ing and pulling it out of the unit.
tions. -

Please Note: -

* Should you need to send your unit to a Service
Center, consult your dealer first.

* Please use the original carton and all of the
original packing material.

® Improper repacking of the unit may result in a
service charge to repair the unit or a cleaning
charge to remove spilled toner,

* Since the unit uses dry toner, extreme care must
be taken when handling. The unit should.be
handled in the upright (vertical) position.

Remove the paper tray by slightly raising
and pulling it out of the unit.

Material Required:
* Qriginal Unit Carton and Packing Materials r
* Original Process Unit Packing Materials
* Newspaper or drop cloth

* Shipping Tape and Scissors

Disconnect the pow_ér cord and the unit/
computer cable.

5 Open the left cover.

2 © Close the paper output support and the
output tray (top cover).
® Remove the document feeder tray by
slightly raising and pulling it out of the
unit,

Remove the Process Unit by holding the
green labeled tabs and pulling it toward you.

9 1eydoy?d
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Care and Maintenance

7 © Place the protective sheet over the green 8 Install the Process Unit by holding the green
drum. labeled tabs and pushing it into the unit.

© Put the Process Unit into the plastic bag
and close the bag.

9 Close the left cover.

-
Repack the unit

Power Cord )
Floppy Disks

Document Output Tray

Paper Tray

Document Feeder Tray
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Options and Supplies |

Please contact your local Panasonic dealer for availabil-
ity. The following options and supplies include Instruc-
tions/Installation Manuals.

_ Options

KX-P447 1 MB RAM Expansion Board

KX-P448 or 2 MB RAM Expansion Board

KX-PEM5

KX-PEM8 4 MB RAM Expansion Board

Supplies_

KX-PST1 Toner Cartridge — 2,500 page life

KX-PEP4 Process Unit — 15,000 page life
T - T T T e T T e T e il
. Note:

|
, * Page life is based upon printing 4% image area i
f with repetitive printing of 10 pages. ' I

R ——— RO |

Installing a RAM Expansion Board

For printing adocument: [tis recommended to install
one of the optional RAM Expansion Boards depending
on the quantity of the print data. To print a complicated
document such as photo, installing 4 MB Expansion
Board is recommended.

For copying documents: It will take longer to copy a
number of documents or a document with 300 x 600, It
is recommended to install the 4 MB RAM Expansion
Board to print faster { oz P. 47).

When the print is faint and the toner message is dis-
played, the toner supply may be almost depleted. How-
ever, the unit may print additional pages if you shake the
Process Unit a few times. Fill the toner in the Process
Unit using toner cartridge KX-PST1. The instructions
below are the outline procedure. For detailed instruc-
tions, please refer to the KX-PST1 instructions manual.

B Extending the toner life:

1 Shake the Process Unit.

W Refilling the toner:

1 Turn the power OFF.
2 Open the left cover.

3 Remove the Process Unit by holding the green
labeled tabs and pulling it toward you.

4 Place the protective sheet over the green drum.

5 Open the toner cover of the Process Unit.

6 Remove the affixed protective sheet from the
toner cartridge.

7 Match the arrow on the toner cartridge with the
arrow on the Process Unit, place the toner car-
tridge on the Process Unit. While pressing the
toner cartridge down, slide the toner cartridge to
the left until it stops.

- 8 Shake the Process Unit, and tap the toner car-
tridge to allow the toner particles te fall freely into
the Process Unit.

9 Remove the toner cartridge by sliding it to the
right and lifting. :

|
| * Use of toner other than Genuine Panasonic
' Toner KX-PST1 can damage this process unit
]
i

and the unit's fuser. THIS WILL VOID THE
WARRANTY OF THE UNIT AND PROCESS
UNIT.

* Do not expose the Process Unit to direct sun-
light or artificial light for more than 5 minutes.

T
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Appendix

Specifications

Power Source:

Refer to the nameplate on the rear of the unit

RAM Buffer:

512 KB (expandable to a maximum of 1.5 MB with optional
1 MB RAM Board, 2.5 MB with 2 MB RAM Board and 4.5
MB with optional 4 MB RAM Board.)

' Operating Environment:

10 to 32.5°C {50 to 90.5°F}
20to 80% RH

Storage Environment:

0 to 35°C {32 to 95°F}
10 to 80% RH

Dimensions:

191 (W) x 404 (D) x 292 (H) mm {7.5” x 15.9” x 11.5"}
422 (W) x 404 (D) x 477 (H) mm {16.6" x 15.9" x 18.87} *2

Mass {Weight}:

Approx. 8.8 kg {19.4 Ibs.}

Consumables/Life:

Starter toner *'; 1,000 pages average (4% image area
with repetitive printing of 10 pages)

Toner cartridge; 2,500 pages average (4% image area
with repetitive printing of 10 pages)

Process unit; 15,000 pages average {4% image area
with repetitive printing of 10 pages}

4% image area means that the black area within the

printing area is 4%. Printing 8% image area continuously

will reduce the life of the toner and of the Process Unit to

about half as compared to printing 4% image area.

4% Image area

[
. et . KA PR (Toner ife}
g . . i 4 - 11 P s e i B Bt s Sheels
- T e e e i 41 vl
P——
O
o 2yt 2 — R SIS By ek B
— ———
ol v aiiohiimerion e 2000 -
TS m e " Average
My Capidy R use
— 1000
— et b e
e i = i L
-
T Pl g Wi 1 1 1
e i o e
- —— [ 10% 15%
—_ .
—_—— e {Image area)
e i it o e

Noise Level:

Printing/Copying: 45 dBA
Standby: Background noise level

CPU:

Motorola MCG8ECO00 (16MHz)

~ Power Saving Mode:

To conserve energy and reduce operating cost, this unit is
provided with a power save feature. If the printer has not
received data for 15 minutes, the unit will automatically
enter a power saving mode.

*1 This toner is installed in the Process Unit at the factory
befare shipment of the printer.

*2 The document feeder support is extended and the
document out support is opened.

Printer Block

Printing Method:

Semiconductor Laser

* Print Speed:

]

6 pages per minute (ppm) maximum {Letter size paper,
text mode, 5% image area, all originals)

Resolution:
600 dots perinch (dpi} [GDI mode] and 300 dpi [PCL mode]

Paper Feed:

1 Multi-purpose tray up to 100 sheets [75 g/m? (20 Ibs.)]
Paper Qutput:

Up to 50 sheets

Software Emulation *2 :

HP LaserJet Series lIP

Fonts:

GDI mode:

{TrueType fonts in Windows)

PCL mode:

Courier 10 point, 12 pitch: Regular, Bold, ltalic
Courier 12 point, 10 pitch: Regular, Bold, lalic
Line Printer 8.5 point, 16.66 pitch: Regular

Interface:

- Power Consumption:

600 W TYPICAL (Printing with Fuser on)
9 W TYPICAL (Power Saving Mode)

84

Bidirectional parallel ({IEEE P1284-B)

*3 Emylation means to operate like another printer.
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R R

opier Block

Paper Used for Printing

} Paper Feed

Auto document feed up to 20 sheets of paper (20 Ibs }

Document Size

Width 89 to 216 mm (35" tc 8 57)
Length 55to 356 mm (2 17" to 14}

| Document Weight

60 to 120 g/m? (16 to 32 Ibs ) for continuous scanmng
60 to 135 g¢/m? (16 to 36 |bs ) for single page scanning

| Effective Scanning Width

Max 208 mm (8 197)

Scanming Resolution

Honzontal 300 [dots per inch (dp1)]
Vertical 300, 600 *’

(Copying The scanned data 15 printed with
600 x 600 dpi)

OCR point size range *2

8~72 point type

Scanner Interface

TWAIN

Image Scanner Type

Contact image sensor

Scanning Speed *3

Maximum scanning speed 5 pages per minute (ppm)
document feed speed, when scanning a Letter size
document with 300 x 300 dpi in text mode

Copying Speed

Maximum copying speed 4 copies perminute (cpm), when
continuously making copies of more than one Letter size
document

(6 cpm, when making more than one copy in téxt mode
of an original Letter size document with 5% image area )

*1 600 dpi 1s not available in Stand Alone Copier function

*2 The recognition rate for Point Type less than 8 will get
worse, however for greater than 8 Point Type the font
may negatively effect the recognition rate

*3 Excludes the ime to transter the scanned data to PC
and display it

This unit 1s designed to work well with most types of
paper However, differences in paper may have signifi-
cant effects on the quality of the pnint or the reliability of
paper handling

It 1s strongly recommended that you always test paper
before purchasing it to make sure # provides desirable
performance The following guidelines will be helpful

Paper Specifications

[ Basic Weight [
60 to 135 g/m2 (16 to 36 Ibs )

| Thickness {
37to7 5 mis (1 mi=14000")

| Moisture Content |
4% to 6%

| Smoothness: |
100 to 300 Sheffield

| Acid Content [
5 5 PH minimum

I Fusing Compatibility !

Must not scorch, melt, offset maternal, or release
hazardous emissions when heated to 200°C (392°F) for
0 1 second

| Cutting Dimensions |

10 0313 inch of nomunal, corners 80°+4°

[ Gran |
Long grain

| Cut Edge Conditions |
Cut with sharp blades, no paper dust

| Ash Content: |
Not to exceed 10%

[ Curl |
No allowable curl toward the side to be printed

| Packing i

Polylaminated maisture proof ream wrap

' Note-

¢ Please store your paper according to the
recommendations of the manufacturer

| S — .
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Paper and Envelope Sizes

The following paper and envelope sizes are supported
by the KX-PS800.

* Use 7510 90 g/m2 (20 to 24 Ibs.) paper. [Do not use
60 g/m2 (16 Ibs.) paper.]
* Do not load more than 50 sheets in the paper tray.

* Before loading paper in the tray, adjust it so that the
edges are even.

Transparencies and Labels

You may alse print on labels and transparencies that are
made for the unit. Panasonic has tested and found that
the following work satisfactorily.

Note:

¢ \With any label stock, the labels must completely
cover the backing material. (1= figure below)

Medium Name Dimension
Paper Letter B.5"x 11"
(216 x 279 mm)
Legal 8.5"x 14"
{216 x 356 mm}
A4 B27" x11.7”
(210 x 297 mm)
Executive 7.25" x 10.5”
(184.1 x 266.7 mm)
BS = 717" x 10127
(182 x 257 mm)
Ab5 * 5.83"x 8.27"
{148 x 210 mm)
Envelope Business #10 413" x9.5”
(104.9 x 241.3 mm)
Monarch 3.88”" % 7.5"
(98.5x 190.5 mmy}
Internationai 4.33" x 8.66”
DL {110 x 220 mm)
International 6.4”"x9.02”
Cs (162 x 229 mm)

* A5 and B5 size papers can be used only in the GDI
Mode.

OHP trans- 3M154, 3M688, 3M688C, SCOTCHB8803,
parencies  3M/SCOTCH-CG3300, 3M PP2500

Labels AVERY 5160, AVERY 5162
Avery Copier Labels (70 x 36 mmy}
Avery White (105 x 37 mm)

16 labels per sheet
COPY TACK C-16, C-24
ESSELTE DATALINE,
ESSELTE KOPIETIKETTER
15914, 15917, 15920, 15922
FASTONALL COPY-LINE
18-030, 18-033, 18-034, 18-035, 18-036,
18-037

HERMA Copy-print 4455, 4464

Types of Paper to Avoid =

* Extremely smooth or shiny paper or paper that is
highly textured

* Coated papers

* | etterhead imprinted with low temperature or ther-
mography. These materials may transfer onto the
fusing roller and cause damage. Any pre-printed paper
should use inks compatible with 200°C (392°F) for 0.1
second.

* Damaged or wrinkled paper, or paper with irregulari-
ties such as tabs, staples, etc.

* Multipart forms or carbonless paper

* Paper with a cotton and/or fiber content over 25%

Two-Sided Printing

Two-sided printing is possible. However, you should not
expect the same print quality and reliability that you get
with one-sided printing. We strongly recommend that
you follow the guidelines below.
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Envelope Specifications

It is recommended that you purchase only high quality
envelopes with diagonal seams, as shown in the dia-
gram below:

High quality envelopes have the following characteris-
tics:

* A thin, sharply creased leading edge
* Paper weight or 90 g/m? (24 Ibs.)
* Flat, free of curls, wrinkles, nicks, etc.

It is not recommended that you use envelopes with any
of the following characteristics (using these may result
in paper jams):

* Irregularly shaped envelopes

* Envelopes with curls, wrinkles, nlcks twists, dog-ears
or other damage

* Envelopes with side seam construction

¢ Highly textured envelopes, or with extremely shiny
surfaces

* Envelopes that seal by removing a peel-off strip

* Envelopes with more than one flap to be sealed

* Self-adhesive envelopes

¢ Envelopes that are baggy or not sharply creased

* Embossed envelopes

* Envelopes that have previously been printed on

Do not attempt to print on any of the following types of
envelopes. These may cause damage to your unit.

* Envelopes with clasps, snaps or tie strings
(see Figure 1)

* Envelopes with transparent windows (see Figure 2)

* Envelopes that will melt, discolor, scorch offset or
release hazardous emissions when exposed to 200°C
(392°F) for 0.1 second

* Envelopes that use encapsulated types of adhesive
that do not require moistening but rely on pressure to
seal them

AN
=)
~—>"

Figure 2

Figure 1

& o,
Side seam Peel-off strip Multiple flaps
construction
- . >

AQ
Twist Bent-edge

(\v )
Wave Dog-ears Self adhesive

Always test-a-sample-of the envelopes.you.are thinking
of buying. Confirm that the envelope performs accept-
ably.

For best printing results
* Avoid printing in high humidity i.e., above 70%.
High humidity may cause the envelope to curl and pick
up excess toner.
High humidity may also cause the envelope to seal.
* Avoid printing below 10°C (50°F) with less than 30%
relative humidity.
Low temperature with low humidity may cause light
printing.

Envelope storage is very important. Store them away
from moisture and humid air, where they can lay flat and
their edges won't be bent or damaged. The humldlty
should not exceed 70% RH.
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Interface Specifications

Parallel Interface connector (printer side)

Bidirectional Parallel

Interface

The bidirectional parallel interface is based on the IEEE
P1284-B standard.

If your computer has a bidirectional parallel port, the
printer driver and unit can take advantage of the fastest
possible data transfer,

Notes:

Specifications: . .
* "Return” denotes the return side wire of a

connector type 57-30360 (AMPHENOL) or twisted pair cable and is connected to signal
equivalent ground. , o
- . * Be sure to use only a shielded cable. The unit
cable use a shielded cable 2 meters " will not operate properly if any of the pins are
(6.6 feet) or less in length . not connected.

Pin configuration (printer side)

Signal pin Retu;?nside Signal
1 19 nStrobe
2 20 Data 1
3 21 Data 2
4 22 Data 3
5 23 Data 4
6 24 Data 5
7 25 Data 6
8 26 Data 7
9 27 Data 8
10 28 nAck
11 29 Busy
12 28 PError
13 28 Select
14 30 nAutoFd
15
16 5G
17 FG
18 +5V

31 30 ninit
32 29 nFault
33

34

35

36 30 ‘nSelectin
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AddingToner . . . . ... ... ... . .. .... 83
Bidirectional parallel interface . . . . . . . . g, 84,88
Button
COPY . ... .. .. . . ... . .. ... 13,70
Cable . . . .. .. . ... ... .. ... 88
Carlonenclosures ., . . ... ... ....... 12
Caution . . . . . . . .. .. . 3
Cautions . . ... ..... e 10
Changingthe printmode . . . . . . . ... “.. .29
Cleaningthe Unit . . . . . .. ... ... ..... 72
external . . ... ... L oL 72
intemal . . ... ... L L oo 72
Configuration Overview . . . . . . . .. .. oe- 19
Installing the Network cennection . . . . . . .. 20
Network Configuration . . . . .. . ... . ... 19
Client . . . . .. .. ... .. ... ..... 19
Server . ... o 19
Network example . . . ... .. .. e 20
Personal Configuration . . . . . ... ... ... 19
Connectinga ClientPC . . . . ... ... ... .. 26
Connecting the Unitand PowerOn . . . . . . . .. 16
Connectortype . . . .. ... .. .. ....... 88
Consumables/Life . . . . . .. ... ... ..... 84
CopierFunction . . . . .. ... ... ... .. 9,70
Copies . .............. . -36,37,43, 44
COPYbutton . . ... ............. 13,70
Desktopprogram . . . . . ... .. ... ..... 50
Desktopwindow . . . . .. ... ... ...... 50
Controlcenter . . ... ........... 50, 51
Menubar . . . ... .. ... L. 50
Statusbar. . .. ... ... L. 50, 51
Toolbar . . .. .. ... ... ... . ..., 50
Workspace . . . .. ... .. L. 50
DestinationPanel . . . . ... ... ... ... 9,47
LocalCopy . . . ... .. .. .. .. ...... 47
Managerbutton . . . . . . . ... ... .... .49
ScantoDesktop . . ... ... ......... 47
ScantoFax . .. ................. 47
Scan to Microsoft Paintbrush (Paint) . . . . . . . 47
ScantoOCR . . . ... ... .......... 47
ScantoPCandPrinter . . . . .. ... ..... 47
DeviceStatus . . . . . ... ... ... .. .... 45

Documents’. . .. . ... ... .. .. .. ... 46
~Acceptable. . . ... ... ... ........ 45
Unacceptable . . . ... .. .......... 46
Document feedersupport . . . . . . ... .. 12,15
Documentoutputtray . . . . . . .. .. ... 12,15
Duplexprinting . . . . ... ... ... ...... a8
. E
Editingdocuments . . . .. ... ... ... ... 56
Rotating document .. .-. . . ... .. ..., 56
Emulation . ... . ... ... ... ... .... 84
Envelopes . . . ... ... ... ...... ... 18
loading . . . . .. .. ... ... ... .. 18
SiZzes . . . ... 86
specifications . . . .. ... ... L. 87
Errorindication . . . . . .. . ... ... ... .. 77
Errormessages . . .. . ... ... .. .. ... 78
. F |
Feedroller . . . . . . ... ... ... ...... 73
Fonts . . . . . . . . . . ... .. ... ... 84
Frame ground terminal . . . . . .. ... ... 12,16
-
GDIMode . .. .. .. ... ... ....... 8, 36
GDlwindow . . ... ... ... ......... 36
Copies . . . . .. .. ... ... 36, 37
Last page on top (Reverse Order) . . . . . . 36, 37
Options . .. ... ... .......... 36, 37
Orientation . . . . ... ... ... ..... 36, 37
Landscape . ... ... .. ....... 36, 37
Portrait . . .. .. ... ......... 36, 37
PaperSize . . . . .. .. ... ... .... 36, 37
PaperSource . . ... ... ... ..... 36, 37
Resolution . . . . . . ... P ... 36,37
2Up/4Up . . ..o 36, 37, 42
Use Print Manager . . ... ........ 36, 37
I
Image Options screen . . . . . . ... ... L. a2
Brightness Contro! . . . . . .. . ... ... .. 42
ContrastControl . . . . .. ... .. ...... 42
Importing/Exporting documents . . . . .. .. .. 59
Indicators . . . . ... ... ... 12,13
ERROR . .. .. .. e e 13
READY . .. . ... ... .. ... ... 13
TONER/PROCESSUNIT . . . .. ... .. .. 13
Installation
processunit . . . . ... ..., 14
trays . . . . . .. e 15
Interface cable, parallet . . . .. .. ... .. 16, 88
Interface connector, parallel . . . .. ... .. 16, 88
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KX-PS600software . . . . . . .. .. ... ... 22
Installing the Image Management Utilities . . . 22
Removing . . . . . .. ... ... 27

labels . . .. .. ... ... ... . ... 17, 86

Landscape . . . ... .. ....... 36, 37,43, 44

Leftcover . . .. .. ... .. ... ... 12, 14

Linked Applicationtray . . . ... ... ... .. 60

Linked Programs . . . . . .. .. .. .. .... 60
Addingalink . . . ... .. ....... ... 60
Deletingalink . . . . . ... ... ... ..., 61
Modifying an existing link . . . . ... .. ... 61
Sending a document to a linked program . . . . 60

LoeadingPaper . . . . . .. .. .. ... .. ... 17
Envelopes (Labels, Transparencies) . . . . . . 18

Making Annotations . . . . . . .. .. ... 57
AddingText . . . . . . ... .. ... . ... 58
Cutting, Copying, Cropping . . . . . . . . ... 58
Erasing . ... ... ... ... ... ... 57
Highlighting . . . . . .. ... ... ... ... 57
StickingNotes . . . . . . ... ... .. .... 58

Managingdocuments . . . . . . . .. ... ... 53
Arrangingdocuments . . . .. ... ... L 55
Creatinganewdocurnent . . . . . . ... ... 54
Deletingdocuments . . . . . .. .. ... ... 55
Duplicating documents . . . . . .. . . . ... 54
Moving documents . . . . . .. .. ... 54
Renamingdocuments . . . ... .. .. ... . b4
Searching a document . . . . . .. ... ... 53
Viewing document information . . . . . . . . . 54

Minimum Space Requirements . . . . . . . . .. 10

Multi-pagedocuments . . . . . . .. .. ... .. 55
Creating . . . . . . ... ... ... ...... 55
Navigating . . . . . .. .. ... ... .. ... 55
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FOR USERS IN THE CONTINENTAL
UNITED STATES ONLY

Panasonic Warranty Policy

Panasonic Computer Peripheral Company (“PCPC”) will repair or exchange your unit (exclusive of Consumables
and Limited Life ltems listed below) with a new or comparable rebuilt, reconditioned or reclaimed unit in exchange
for the defective unit, free of charge, in the U.S.A. for (1) year from the date of original purchase in the event of
a defect in materials or workmanship. '

Consumables and Limited Life Items

PCPC will repair/replace the Process Unit and/or Toner with new or rebuilt, reconditioned or reclaimed parts,
free of charge, in the U.S.A. for the shorter of ninety (90) days from the date of original purchase or the rated
life of the item in the event of a defect in materials or workmanship.

When you unpack your unit, you should find a proceés unit and power cord. If either/both of these parts are
missing or defective,

If you have followed the set up instructions in this Operating Instructions manual and the unit fails to turn on or
“CALL SERVICE Exx” appears on the computer screen, please call 1-800-222-0584.
{(xx denotes a two digit number representing an error code)

Ny J

Panasonic Computer Peripheral Company

Division of Panasonic Communication & Systems Company
Unit of Matsushita Electric Corporation of America

Two Panasonic Way, Secaucus, New Jersey 07094

Panasonic Sales Company

Division of Matsushita Electric of Puerto Rico, Inc.
San Gabriel Industrial Park, 65th infantry Avenue KM. 8.5
Carolina, Puerto Rico 00630

Matsushita Electric of Canada Limited
5770 Ambler Drive, Mississauga, Ontario, L4W 2T3

Matsushita Electric Industrial Co., Ltd.
Central P.O. Box 288, Osaka 530-91, Japan

Printed in Japan : 7 PJQMAQ122ZA S089610
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